The Macintosh Joker

Don't get mad—get even!

Create chaos, mayhem, and devilish pranks on the Mac

It's wild!

Disk contains 33 cruel tricks!
The Macintosh® Joker
The Macintosh® Joker
A Collection of 33 Cruel Mac Tricks

by Owen W. Linzmayer

Hayden Books
We Want to Hear from You!

What our readers think of Hayden Books is important to our ability to serve our customers. If you have any comments, no matter how great or how small, I'd appreciate you taking the time to send us a note.

I can be reached at the following address:

David Rogelberg
Hayden Books
201 West 103rd Street
Indianapolis, IN 46290

(800) 428-5331 voice
(800) 448-3804 fax

E-mail addresses:
America Online         Hayden Bks
AppleLink              hayden.books
CompuServe             76350,3014
Internet               hayden@hayden.com

If this book has changed your life, I would like to hear how and why. Do you have a great book idea? Please contact Hayden Books at the above address.

Sincerely,

[Signature]

David Rogelberg
Publisher, Hayden Books
Dedication

To my wife Alane and my cat Nutella, 
two mischievous girls without a cruel bone betwixt them.
About the Author

Owen W. Linzmayer is a San Francisco-based freelance writer who contributes regularly to MacUser and Macworld magazines. He is the author of *Totally Rad Mac Programs*, and over the past dozen years has held editorial positions at numerous personal computer magazines.
Acknowledgments

This book would not be possible without the sick minds from whence sprung the 33 programs included on the accompanying disk. Therefore it’s only fitting that I pay homage to the twisted souls who slaved over keyboards writing programs to mess with Macs. I don’t know what shared genetic defect drove them to create such great stuff, but they deserve the lion’s share of credit.

I’d also like to extend my sincerest thanks to you, dear reader, for having the good judgment and bad taste to buy this book. If you’re standing in a bookstore debating whether or not to make the plunge, I recommend you hustle over to the counter and lay down your greenbacks, pronto. If your enemies have already picked up their copies, you’ll appreciate knowing how to defend yourself when they decide to attack your Mac, instead of the other way around. Besides, I don’t make squat unless you actually buy the book. Call me funny, but I appreciate people more if their actions somehow cause little pieces of green paper with pictures of dead white men to appear in my mailbox. So if you have a deep-seated need for social acceptance, buy this book and I’ll fulfill my end of the deal by thinking fondly of you. Money can’t buy you love, but it can purchase a reasonable facsimile thereof.

Thanks also to the hundreds of misfits who ordered my Cruel Mac Tricks disk, a motley collection of programs that spawned this book you hold in your hands today. They shared my vision, psychotic though it may be, and in so doing inspired me to seek a larger audience. As a result, I prompted my agent, Carole McClendon of Waterside Productions to earn her pound of flesh and shop the concept around to a number of publishers (yeah, I know, the whole affair sounds so commercial and “Hollywood” that it embarrasses even me). Ultimately we found an acquisitions editor not afraid to take a chance with her reputation and her employer’s money. So thanks to Karen Whitehouse and all the other fine professionals at Hayden.

I am also grateful for the various contributions made by the following people: Mark Bankins (Sound Source Unlimited, Inc.), Roger S. Bloxberg (Nova Development Corp.), David Gewirtz (Component Software Industries Corp.), Bob LeVitus, Alex Louie, Mike Miley, Ivan Reitman (Ivan Reitman Productions), Dave Schutz (Alikchi Graphics), Mark Simmons, and Phill Simon (Axis Graphics).

Finally, I would like to send as much negative energy as possible to the lawyers, licensing directors, agents, and other small-minded power-trippers who thwarted my every effort to obtain permission to include some really cool copyrighted material in this book. Thanks for nothing. Y’all better hope I don’t get nowhere near your computers with this book in hand…
# Table of Contents

Introduction ..................................................................................................... 1

Part I  **Startup Tricks**  7

1  StartupScreens .......................................................................................... 9
2  DOS sHELL ................................................................................................. 13
3  Minitors ....................................................................................................... 15
4  BrokaMac ..................................................................................................... 17
5  FlyPaper ...................................................................................................... 21
6  Solvent ......................................................................................................... 25
7  Playin’ Possum ......................................................................................... 29

Part II  **Text Tricks**  33

8  Backwords .................................................................................................. 35
9  Moof ............................................................................................................. 39
10  Ümlâût Ômêléttê ......................................................................................... 43
11  Vanish ........................................................................................................ 45
12  HAL Edit .................................................................................................... 49
13  Mitten Touch-Typist ................................................................................ 53
14  NVwls ......................................................................................................... 55
### Part III  Sound Tricks

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>Conan The Librarian</td>
<td>59</td>
</tr>
<tr>
<td>16</td>
<td>Off Hook</td>
<td>63</td>
</tr>
<tr>
<td>17</td>
<td>MacBarf</td>
<td>65</td>
</tr>
<tr>
<td>18</td>
<td>Sneezomatic</td>
<td>69</td>
</tr>
<tr>
<td>19</td>
<td>Sniff</td>
<td>73</td>
</tr>
<tr>
<td>20</td>
<td>Tweety</td>
<td>77</td>
</tr>
<tr>
<td>21</td>
<td>Sonic Boom</td>
<td>81</td>
</tr>
<tr>
<td>22</td>
<td>Squeaker</td>
<td>85</td>
</tr>
</tbody>
</table>

### Part IV  Menu Tricks

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>23</td>
<td>Enchanted Menus</td>
<td>91</td>
</tr>
<tr>
<td>24</td>
<td>MenuHack</td>
<td>93</td>
</tr>
</tbody>
</table>

### Part V  Miscellaneous Tricks

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>April Fools</td>
<td>97</td>
</tr>
<tr>
<td>26</td>
<td>Burning Fuse</td>
<td>99</td>
</tr>
<tr>
<td>27</td>
<td>Dimwit</td>
<td>101</td>
</tr>
<tr>
<td>28</td>
<td>Munch</td>
<td>103</td>
</tr>
<tr>
<td>29</td>
<td>Sexplosion</td>
<td>107</td>
</tr>
<tr>
<td>30</td>
<td>Sproing</td>
<td>109</td>
</tr>
<tr>
<td>31</td>
<td>Termites</td>
<td>111</td>
</tr>
</tbody>
</table>
# Table of Contents

## Part VI  Network Tricks

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>32 NetDino &amp; StartDino</td>
<td>117</td>
</tr>
<tr>
<td>33 Radiation &amp; Trigger</td>
<td>121</td>
</tr>
</tbody>
</table>

## Appendices

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Troubleshooting</td>
<td>129</td>
</tr>
<tr>
<td>B Installation</td>
<td>133</td>
</tr>
<tr>
<td>C The Programs</td>
<td>135</td>
</tr>
</tbody>
</table>
Introduction

Everybody knows somebody that deserves taking down a notch or two. Perhaps it's the office busy-body, some know-it-all employee, an egomaniacal teacher, a family member, or all of the above when you're having a bad hair day. For the sake of consistency, we'll call these charming folks your "victims." This book contains a collection of applications, control panels, and extensions that allow you to take pleasure in the misfortune of these victims. Please note that as I write this, my tongue is firmly planted in cheek. I don't really want to see anyone get hurt or even seriously upset as a result of this book. Face it, if it was your intention to cause some serious grief, you could simply erase your victim's hard drive or steal their Mac altogether. Now that I've put the morality of things into perspective for the politically correct and humor-impaired readers among us, let's move on.

If one of the blow-dried talking airheads on the 6 o'clock news were covering this book, they would probably call these programs viruses. As usual, they would be wrong. Unlike these tricks, viruses are harmful and aren't funny at all. All of the files included in this book have been scanned with the most current versions of five different virus-detection utilities. According to these utilities and the assurances of the programmers, these files are free from known viruses and Trojan Horses. But if it helps you sleep better, double-check for yourself before installing the files on any Mac (you might uncover some viruses elsewhere as a bonus). Furthermore, I recommend that you write-protect the original disk and use it only to make a backup from which you actually install the files.
In selecting the 33 files to include in this book, great care was taken to make sure that none of the programs harms your victim's Macintosh, its peripherals, or its data in any way. However, these programs simulate various malfunctions and screw-ups that naïve users may incorrectly interpret as serious problems. That's part of the fun, but therein lies a great danger.

In their attempts to "fix" what isn't really broken, overzealous victims may tear out their hair and tear apart their systems. Who knows, they may reinstall their System software, reformat their hard drives, or even take their Macs in for unneeded repairs. While the very idea of such drastic actions may have you laughing fiendishly like Charles Manson at the prospect of a weekend pass, think how you would feel if someone played a similar prank on you just before a major deadline. Now, it's not so funny anymore, is it? For this reason (and to cover my butt in case someone gets really mad and tries to sue), let me state for the record that it's entirely up to you to use these programs in a responsible manner. Do we have a deal? (This being a book, and therefore not entirely conducive to two-way communication, it's a safe bet that was a rhetorical question, so now is a good time to nod your head in agreement and proceed to the next paragraph.)

**General Tips**

Before inflicting any of these programs on your victims, I suggest the following course of action. First, read the program's chapter from start to finish. I mean it. Make sure you understand what the program should do and—this is very important—how to disable or deinstall the program. Then, play the trick on your own Mac to make sure it works as described. If so, go ahead and install the program on your victim's Mac when they aren't looking.

Some anti-viral utilities may prevent you from installing these tricks as described. That's not because these tricks contain viruses, it's just that these utilities are designed to prevent all unauthorized installations. So wherever possible, disable these utilities before attempting to install the tricks on your victim's Mac.

Also, some people use INIT or extension managers which control files that load upon startup. It's possible that the standard installation instructions might not work if your victim uses such a utility. The most common problem is that the utility doesn't just load any ol' file dropped into the System folder, but rather, requires you to specifically tell it to load. If that's the case, you must figure out how the utility works without raising the suspicions of your victim. The other thing to look out for is that extension managers may alter the normal loading order of extensions, control panels, and other files. This can be troublesome for certain tricks which work best if
they load at a particular time, such as first or last. Again, do some homework to determine how to specify the load order. It’s best to turn off all other extensions to avoid any unforeseen compatibility problems.

Before leaving the trick for your victim to discover, check to see that the program works as expected on their Mac. (If anything seems out of the ordinary, abort the mission and deinstall the software.) Finally, make sure you are around the victim when the trick is played. Not only are these tricks a lot more fun when you get to see your victim freak-out trying to make sense of a Mac gone mad, you’ll also be on hand to make sure they don’t do anything drastic. After you’ve had your laughs at your victim’s expense, you should at least be kind enough to revert their system back to normal. It’s up to you whether you let them in on the gag or you make up some techno mumbo-jumbo to explain away the misbehavior. If you want to be kind and cruel at the same time, surreptitiously install a different trick program when removing the old one. Your victim will be sure that their Mac is possessed!

With a few exceptions, all of the tricks can be temporarily disabled by restarting and holding down the Shift key during startup under System 7, or the Command key under System 6. Then to permanently deinstall, remove the trick from the System file and drag it into the Trash.

Covering Your Tracks
Most of these programs have rather obvious names and icons that are dead giveaways to anyone searching for the cause of erratic behavior. After installing on your victim’s Mac, you can give these files more innocent names such as Word Pref or Scrapbook Catalog. Under System 6, click the file name until it’s highlighted (under System 7, wait for a box to appear around the name), then type an innocuous new name. Since most people don’t really know exactly what belongs in their System folder, this is the easiest way to throw your victim off your scent. Just remember any new names you assign so that you can deinstall the tricks when the time comes.

Another great trick is to change a program’s icon to something generic and harmless-looking. Doing so under System 6 is a little difficult and requires a utility such as Apple’s ResEdit. However, it’s a breeze with the Finder in System 7. Simply click once on a file whose icon you want to appropriate, then choose Get Info (Command-I) from the File menu. In the window that appears, click the icon in the upper left so that it’s surrounded by a box. Choose Copy (Command-C) from the Edit menu to place a copy of the icon on the Clipboard. Close this window (Command-W) and then open the Get Info window for the trick you are trying to
disguise. Click the trick's icon to select it, then choose Paste (Command-V) from the Edit menu to replace the trick's icon with the one you copied to the Clipboard earlier. If you ever want to revert to the old icon, just highlight the icon in the Get Info window and press Delete.

Finally, the best way to keep your victim from stumbling upon a trick is to make it invisible altogether. The Mac relies on a number of invisible files all the time, but there's no legitimate reason for most users to make files invisible, so the Finder doesn't provide an easy way to accomplish this task. You could flip a file's Invisible bit with a program such as Apple's ResEdit or Symantec's Norton Utilities, but as a precaution against viruses, the Mac won't load invisible extensions. No sweat. I've devised a cool work-around.

Click once on the file name to highlight the trick's name (under System 7, wait for the name to be surrounded by a box), then press Option-space to replace the entire name with a blank space. That takes care of hiding the name. Now for the icon. Using the System 7 tip described earlier, replace the trick's icon with a copy of the blank icon that I've provided on disk. Simply click once on the Blank Icon file, then choose Get Info from the File menu. In the window that appears, click the invisible icon in the upper left so that it's surrounded by a box. Choose Copy (Command-C) from the Edit menu to place a copy of the icon on the Clipboard. Close this window (Command-W) and then open the Get Info window for the trick you are trying to hide. Click the trick's icon to select it, then choose Paste (Command-V) from the Edit menu to replace the trick's icon with the invisible one you just copied to the Clipboard. If you ever want to revert to the old icon, just highlight the icon in the Get Info window and press Delete.

Now your trick is almost completely invisible. I say "almost" because it shows up as a blank line when you view the contents of folders by Name, Size, or Kind. Also, its icon may appear during the startup process. Still, as far as most users are concerned, it'll be harder to find than that Waldo goofball.

The Fine Print
I hope you enjoy using the programs in this book. I've tested them extensively on a variety of Macs running System 6.0.8 and System 7.1, but my experience with lawyers prompts me to advise you that these programs are provided "as is," which means they may or may not work correctly on your victim's particular Macintosh configuration (any resemblance to a weasel-like disclaimer that absolves me of all responsibility is purely intentional). When in doubt, please consult the "Compatibility Notes" section in each chapter, disable all non-essential extensions, and upgrade to the most current System software.
Neither the author (that's me), the programmers, or the publisher shall be held liable, under any circumstances, for any damages or inconveniences these tricks may cause. By installing these programs on a Mac, you alone agree to accept all liability for any damages or losses inflicted.

As you've no doubt concluded by now, I regret to say that technical support is not available from my publisher or myself. But then, the programs in this book are so limited in what they do that it's unlikely you'll have many questions about how to use them. Either they work as described, or they don't. If you experience a problem using a particular trick, your best bet is to notify the programmer using the information listed in the "Contacting the Programmer" section at the end of each chapter. Also, although I can't promise to provide a fix if a program doesn't work as described, I sincerely want to know if you have problems (I mean with the programs... the fact that you bought this book makes it a foregone conclusion that you suffer from mental problems). Please specify the type of Mac being used, the version of the System software, and a brief description of what went wrong.

**Be Strange, Not a Stranger**

I love to hear comments about my books from readers like yourself. If you'd like a personal reply, please include a self-addressed stamped envelope. A small monetary bribe wouldn't hurt either.

Even if you have nothing to say about the book, I would really appreciate it if you would drop me a postcard with your name and address so that I can notify you of general updates, bug fixes, and other special software and book offers available exclusively to readers such as yourself. Don't worry, I never make my database available to other companies or organizations because I suspect that you don't like junk mail any more than I do.

Oh, yeah, one last thing. If you have written, discovered, or thought up some other insidious Mac tricks, please send me a copy so that I can share them with deviants like yourself. I look forward to hearing from you soon!

Owen W. Linzmayer
2227 15th Avenue
San Francisco, CA 94116-1824

AppleLink: Owen
America Online: Owen Ink
CompuServe: 71333,3152
Startup Tricks

The first seven tricks covered in this book all affect the startup process in one nasty way or another. Normally your victim's Mac displays an insipid "Welcome to Macintosh" greeting as icons of extensions and control panels march along the bottom of the screen until the Finder's desktop appears. StartupScreens replace the "Welcome" greeting with images of a broken Mac. DOS sHELL momentarily transforms the Mac into an IBM PC. Like a thief in the night, Minitors is a sneaky trick that steals pixels to slowly decrease the size of the screen. BrokaMac makes it look and sound like something is seriously wrong with the display. The desktop sticks to the cursor with FlyPaper, or melts away entirely with Solvent. Finally, a bugle sounds "Taps" in the background just before Playin' Possum turns off the Mac.
One of the coolest features of the Mac is its ability to replace the standard "Welcome to Macintosh" startup greeting with a custom picture. Most people opt for bathing beauties, corporate logos, or family photos. But you’re not most people, and these Startup Screens aren’t intended for viewing on your Mac, they’re for your victim.

These two images are humorous examples of the kinds of Startup Screens you can create with a little imagination. Broken Mac is an image of a broken Mac screen with a circuit board visible along with an "Out of Order" sign (see figure 1.1).

Figure 1.1 A horrendous crash upon startup? No, it’s just Broken Mac Startup Screen.
Melting Mac is a distressed version of the standard “Welcome to Macintosh” greeting (see figure 1.2).

![Melting Mac](image)

**Figure 1.2** *Keep your victims guessing with this alternative StartupScreen.*

It's unlikely that even the most naïve Mac user would take either image seriously, but who knows? Spice things up by using one of these StartupScreens in conjunction with other tricks from this book.

**Installing a StartupScreen**

These two images are included on the disk as both 8-bit color and 1-bit monochrome files. If your victim has a black & white Mac, use the files with B&W appended to their file names.

Begin by renaming the desired file to plain old StartupScreen (that's all one word, with the letter S capitalized in both places). Before dragging the StartupScreen file into the System Folder on your victim's startup volume, remove any existing StartupScreen and stash it in a different folder. Then choose Restart from the Finder's Special menu to complete the installation.

To deinstall a StartupScreen, remove it from the System Folder and restart. If you stashed your victim's original StartupScreen, be a sport and reinstall it.
Modifying Startup Screens
If you want, you can modify these images in a graphics application such as SuperPaint or Photoshop, but you must save the modified file in the StartupScreen (also called PICT resource) file format, and name the file StartupScreen.

Compatibility Notes
Startup Screens work under System 6 and System 7.

Contacting the Artist
Both of these Startup Screens were created by N. Jonas Englund. The Broken Mac image uses the Circuit Board+ pattern from Wallpaper, a cool commercial package by Thought I Could.

N. Jonas Englund
P.O. Box 26
New Canaan, CT 06840-0026

America Online: BusJohnny
AppleLink: N.J.Englund
CompuServe: 71740,2532
GEnie: N.Englund
With the DOS sHELL extension installed, a black screen and the infamous blinking "C:\ >" replaces your victim's familiar "Welcome to Macintosh" startup greeting, just as if the friendly Mac had somehow transformed itself into one of those awful IBM PCs (see figure 2.1). It's enough to drive John W. Hinckley, Jr. insane. Er...nevermind.

Figure 2.1 Your victims will think their Macs have mysteriously turned into IBM PCs with DOS sHELL.

Luckily, pressing any key or clicking the mouse button displays the name of the programmer, and clicking again continues the startup process as normal. Whew!
Installing DOS sHELL
To install DOS sHELL, just drag it into the System folder on your victim's startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder’s Special menu to complete the installation.

To deinstall DOS sHELL, remove it from the System Folder and restart.

Compatibility Notes
DOS sHELL works under System 6 and System 7.

Contacting the Programmer
DOS sHELL is copyright 1991-1993, Jay D. Weiss.

Jay D. Weiss
132 Pembroke Court
Meriden, CT 06450-8100

America Online: JayWeiss
AppleLink: D0467
CompuServe: 70376,1006
Minitors

With the Minitors extension installed, every time your victim’s Mac goes through the startup process, the size of the main monitor is decreased by one pixel. Minitors alternates between stealing pixels from the height and width on successive startups, so the diminishing screen size doesn’t affect the screen’s proportions. And since Minitors erodes only a single pixel at a time, it takes a considerable amount of time before the loss is great enough to notice. When your victim finally catches on, try explaining away the problem by cavalierly mentioning that “Monitors, like people, shrink as they get older.”

If you let Minitors run long enough, Finder icons move over to the left so that they remain visible on the incredible shrinking desktop. Amazingly enough, the Mac is able to function up to the point until the screen is about a quarter-inch high (just enough to display the menu bar), then the Mac harmlessly crashes after startup. In reality, your victim will certainly have noticed Minitors’ ill effects long before this extreme condition occurs.

Installing Minitors

Minitors’ file name already has a leading space so that it avoids detection by loading first. To install Minitors, just drag it into the System Folder on your victim’s startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder’s Special menu to complete the installation.

To deinstall Minitors, remove it from the System Folder and restart.
Compatibility Notes
Minitors works under System 6 and System 7. It decreases the size of the main monitor only (the one on which the menu bar appears); it doesn't affect other monitors even if your victim has multiple displays attached to a single Mac. Some programs (mostly games) may refuse to run if they notice that the screen size isn't one of the standard dimensions that they expect.

Contacting the Programmer
Minitors was written specifically for this book and is copyright 1993, Morgan Davis. Morgan has also written a very useful commercial ($39.95) control panel called MiniScreen that allows you to specify a screen size smaller than what your Mac is capable of using. This is helpful for programmers developing software on a Mac with a large screen but who want to see what their creation looks like on a smaller monitor. But MiniScreen isn't just for programmers. For example, I used MiniScreen to simulate a 9-inch monitor when taking screen shots for this book.

Morgan Davis
Morgan Davis Group
10079 Nuerto Lane
Rancho San Diego, CA 91977-7132

(619) 670-0563
(619) 670-9643 fax

Bulletin board system: (619) 670-5379
America Online: MDavis
BIX: MDavis
GEnie: Morgan-Davis
Internet: MDavis@MDG.cts.com
BrokaMac is an application that simulates a serious hardware failure on your victim's monitor by creating a double-vision image of the Finder's desktop while squealing like a member of Congress about to lose a district military base (see figure 4.1).

Figure 4.1 Is something seriously wrong with your victim's monitor? No, it's just BrokaMac.
When your victim begs for help (or mercy), mumble something about unusually strong sun spots affecting the Earth’s magnetic resonance, blame it on somebody using a microwave oven nearby, or suggest a visit to an optometrist because nothing’s wrong as far as you can see. Then begin fiddling with the monitor controls as you secretly depress the Caps Lock key, causing BrokaMac to quit and the desktop to snap back into place.

In addition to the Caps Lock escape hatch, there is another way of quitting BrokaMac. On Macs with sound input devices—such as the built-in microphones on the newer Macs, or a Macromedia MacRecorder—BrokaMac monitors the ambient noise level and automatically quits whenever it hears a loud sound, such as your exasperated victim screaming, “What the #$&@! is going on here!?” If your victim works in a particularly noisy environment, you can disable this feature simply by adding a space to the end of the BrokaMac file name before installing.

**Installing BrokaMac**

There are different installation directions depending on what version of System software your victim’s Mac uses. If you aren’t sure, look in the Apple menu in the Finder. If the first item is About This Macintosh, the Mac is running System 7, otherwise it’s probably running System 6.

**System 7**

Drag BrokaMac into the Startup Items folder inside your victim’s System Folder. Each time your victim turns on the computer or chooses Restart from the Finder’s Special menu, the Mac immediately launches the contents of the Startup Items folder when the desktop appears.

Since the names of startup items appear in the menu bar when launched, you can cover your tracks by renaming BrokaMac. Click once on the file name to highlight the name. Wait for the name to be surrounded by a box (indicating that it’s ready for editing), then press Option-space to replace BrokaMac’s name with a blank space (if you enter a normal space, BrokaMac won’t quit when it hears a loud sound). Not only does this keep the file name from appearing when the program launches, it also ensures that BrokaMac is the first startup item launched, because the Mac goes in alphabetical order.

To temporarily prevent the Mac from launching BrokaMac under System 7, hold down the Shift key during startup until the “Extensions off” message appears. This tells the Mac not to load any extensions and not to launch any of the startup items.
To permanently deinstall BrokaMac, start the Mac while holding down the Shift key, then remove the BrokaMac file from the Startup Items folder and restart.

**System 6**

Put BrokaMac anywhere you want on your victim's startup volume. Click once on the BrokaMac icon, then choose Set Startup from the Finder’s Special menu. Click the MultiFinder radio button and the radio button marked BrokaMac. This sets up the Mac so that each time your victim turns on the computer or chooses Restart from the Finder’s Special menu, BrokaMac immediately launches when the desktop appears.

Since the names of startup items appear in the menu bar when launched, you can cover your tracks by renaming BrokaMac. Click once on the file name to highlight the name, then press Option-space to replace BrokaMac’s name with a blank space (if you enter a normal space, BrokaMac won’t quit when it hears a loud sound). Not only does this keep the file name from appearing when the program launches, it also assures that BrokaMac is the first startup item launched, because the Mac goes in alphabetical order.

To temporarily prevent the Mac from launching BrokaMac under System 6, hold down the Command key during startup until the desktop appears and the cursor becomes an arrow. This tells the Mac not to launch any of the startup items.

To permanently deinstall BrokaMac, start the Mac while holding down the Command key, then locate the BrokaMac file and drag it into the Trash.

If you choose to start up with BrokaMac using the Finder instead of MultiFinder, its name won’t appear in the menu bar, but holding down the Command key won’t prevent BrokaMac from launching. In this case, to disable BrokaMac you must start the Mac with the Caps Lock key depressed, then locate the BrokaMac file and drag it into the Trash.

**Compatibility Notes**

BrokaMac requires 32-Bit QuickDraw, which is present in System 7 and is available as an extension for any color-capable Mac running System 6.0.5 or later.
Contacting the Programmer

Brokamac was written specifically for this book and is copyright 1993, Kirk Kerekes.

Kirk Kerekes
PaperClip Products
4308 South Peoria Avenue, Suite 763
Tulsa, OK 74105-3922

(800) 497-5508
(918) 749-7417 voice/fax
(918) 744-9796 voice/fax

AppleLink: D5378
Bulletin board system (918) 743-8347
   (Connect and wait to download remote module)
FlyPaper is an application that makes the Finder’s desktop stick to the cursor like a piece of fly paper, so the entire desktop is dragged around the monitor. No matter how hard your victim wiggles the mouse to shake the screen free of the cursor, it hangs on with the tenacity of a pitbull terrier munching on a mailman (see figure 5.1).

Figure 5.1 With FlyPaper, the whole screen sticks to the cursor and is dragged around the monitor.
When your perplexed victim comes crawling for assistance, explain that the cursor occasionally sticks to the pixels due to “vacuum cementing” inside the screen and must be bumped loose. Then gently rap the side of the monitor a few times as you secretly depress the Caps Lock key, causing FlyPaper to quit and the desktop to snap back into place. For maximum effect and obscurity, turn down the brightness knob before you tap the side of the monitor, explaining this action as a method of “temporarily cutting the electron beam flow to reduce friction on the phosphor surface,” or some other nonsense.

In addition to the Caps Lock escape hatch, there is another way of quitting FlyPaper. On Macs with sound input devices—such as the built-in microphones on the newer Macs, or a Macromedia MacRecorder—FlyPaper monitors the ambient noise level and automatically quits whenever it hears a loud sound, such as your victim bellowing “I can’t believe this is happening to me!” If your victim works in a particularly noisy environment, you can disable this feature simply by adding a space to the end of the FlyPaper file name before installing.

Installing FlyPaper
There are different installation directions depending on what version of System software your victim’s Mac uses. If you aren’t sure, look in the Apple menu in the Finder. If the first item is About This Macintosh, the Mac is running System 7, otherwise it’s probably running System 6.

System 7
Drag FlyPaper into the Startup Items folder inside your victim’s System Folder. Each time your victim turns on the computer or chooses Restart from the Finder’s Special menu, the Mac immediately launches the contents of the Startup Items folder when the desktop appears.

Since the names of startup items appear in the menu bar when launched, you can cover your tracks by renaming FlyPaper. Click once on the file name to highlight the name. Wait for the name to be surrounded by a box (indicating that it’s ready for editing), then press Option-space to replace FlyPaper’s name with a blank space (if you enter a normal space, FlyPaper won’t quit when it hears a loud sound). Not only does this keep the file name from appearing when the program launches; it also assures that FlyPaper is the first startup item launched, because the Mac goes in alphabetical order.
To temporarily prevent the Mac from launching FlyPaper under System 7, hold down the Shift key during startup until the “Extensions off” message appears. This tells the Mac not to load any extensions and not to launch any of the startup items.

To permanently deinstall FlyPaper, start the Mac while holding down the Shift key, then remove the FlyPaper file from the Startup Items folder and restart.

**System 6**

Put FlyPaper anywhere you want on your victim’s startup volume. Click once on the FlyPaper icon, then choose Set Startup from the Finder’s Special menu. Click the MultiFinder radio button and the radio button marked FlyPaper. This sets up the Mac so that each time your victim turns on the computer or chooses Restart from the Finder’s Special menu, FlyPaper immediately launches when the desktop appears.

Since the names of startup items appear in the menu bar when launched, you can cover your tracks by renaming FlyPaper. Click once on the file name to highlight the name, then press Option-space to replace FlyPaper’s name with a blank space (if you enter a normal space, FlyPaper won’t quit when it hears a loud sound). Not only does this keep the file name from appearing when the program launches, it also assures that FlyPaper is the first startup item launched, because the Mac goes in alphabetical order.

To temporarily prevent the Mac from launching FlyPaper under System 6, hold down the Command key during startup until the desktop appears and the cursor becomes an arrow. This tells the Mac not to launch any of the startup items.

To permanently deinstall FlyPaper, start the Mac while holding down the Command key, then locate the FlyPaper file and drag it into the Trash.

If you choose to start up with FlyPaper using the Finder instead of MultiFinder, its name won’t appear in the menu bar, but holding down the Command key won’t prevent FlyPaper from launching. In this case, to disable FlyPaper you must start the Mac with the Caps Lock key depressed, then locate the FlyPaper file and drag it into the Trash.
Compatibility Notes

FlyPaper requires 32-Bit QuickDraw, which is present in System 7 and is available as an extension for any color-capable Mac running System 6.0.5 or later.

Contacting the Programmer

FlyPaper was written specifically for this book and is copyright 1993, Kirk Kerekes. Icon courtesy of Component Software Industries Corporation.

Kirk Kerekes
PaperClip Products
4308 South Peoria Avenue, Suite 763
Tulsa, OK 74105-3922

(800) 497-5508
(918) 749-7417 voice/fax
(918) 744-9796 voice/fax

Bulletin board system: (918) 743-8347
(Connect and wait to download remote module.)

AppleLink: D5378
Solvent

Solvent is an application that makes the Finder's desktop melt away like an ice cube in hell or tax dollars in Washington, D.C. To restore order, just click the mouse button (see figure 6.1).

Figure 6.1 They averted a nuclear meltdown at Three Mile Island, but Solvent can't be stopped.
Installing Solvent

There are different installation directions depending on what version of System software your victim's Mac uses. If you aren't sure, look in the Apple menu in the Finder. If the first item is About This Macintosh, the Mac is running System 7, otherwise it's probably running System 6.

System 7

Drag Solvent into the startup items folder inside your victim's System Folder. Each time your victim turns on the computer or chooses Restart from the Finder's Special menu, the Mac immediately launches the contents of the startup items folder when the desktop appears.

Since the names of startup items appear in the menu bar when launched, you can cover your tracks by renaming Solvent. Click once on the file name to highlight the name. Wait for the name to be surrounded by a box (indicating that it's ready for editing), then press the Space bar to replace Solvent's name with a blank space. Not only does this keep the file name from appearing when the program launches, it also assures that Solvent is the first startup item launched, because the Mac goes in alphabetical order.

To temporarily prevent the Mac from launching Solvent under System 7, hold down the Shift key during startup until the "Extensions off" message appears. This tells the Mac not to load any extensions and not to launch any of the startup items.

To permanently deinstall Solvent, start the Mac while holding down the Shift key, then remove the Solvent file from the startup items folder and restart.

System 6

Put Solvent anywhere you want on your victim's startup volume. Click once on the Solvent icon, then choose Set Startup from the Finder's Special menu. Click the MultiFinder radio button and the radio button marked Solvent. This sets up the Mac so that each time your victim turns on the computer or chooses Restart from the Finder's Special menu, Solvent immediately launches when the desktop appears.

Since the names of startup items appear in the menu bar when launched, you can cover your tracks by renaming Solvent. Click once on the file name to highlight the name, then press the spacebar to replace Solvent's name with a blank space. Not only does this keep the file name from appearing when the program launches, it also assures that Solvent is the first startup item launched, because the Mac goes in alphabetical order.
To temporarily prevent the Mac from launching Solvent under System 6, hold down the Command key during startup until the desktop appears and the cursor becomes an arrow. This tells the Mac not to launch any of the startup items.

To permanently deinstall Solvent, start the Mac while holding down the Command key, then locate the Solvent file and drag it into the Trash.

If you choose to start up with Solvent using the Finder instead of MultiFinder, its name won't appear in the menu bar, but holding down the Command key won't prevent Solvent from launching. In this case, to disable Solvent you must start the Mac with the mouse button depressed, then locate the Solvent file and drag it into the Trash.

**Compatibility Notes**

Solvent works under System 6 and System 7.

---

**Contacting the Programmer**

Solvent was written specifically for this book and is copyright 1993, Marcio Luis Teixeira. If you enjoy this program, be sure to send Marcio a $5 check for a copy of his shareware disk which contains many other interesting and useful Mac programs. (Please write “Shareware Disk Request” in the memo field of your check.)

Marcio Luis Teixeira  
P.O. Box 271603  
Fort Collins, CO 80527-1603

America Online: MarcioT
Playin' Possum

Playin' Possum is an application that sounds “Taps” on a bugle and then shuts down your victim's Mac. For best results, make Playin' Possum the startup application and watch as your victim tries over and over to get the Mac to stay on long enough to figure out what's going on (or, in this case, off). For killing productivity, this trick is right up there with a Friday afternoon beer blast.

Installing Playin' Possum
Drag Playin' Possum into the startup items folder inside your victim's System Folder. Each time your victim turns on the computer or chooses Restart from the Finder's Special menu, the Mac immediately launches the contents of the startup items folder when the desktop appears.

Since the names of startup items appear in the menu bar when launched, you can cover your tracks by renaming Playin' Possum. Click once on the file name to highlight the name. Wait for the name to be surrounded by a box (indicating that it's ready for editing), then press the Space bar to replace Playin' Possum's name with a blank space. Not only does this keep the file name from appearing when the program launches, but it also assures that Playin' Possum is the first startup item launched, because the Mac goes in alphabetical order.

Make sure your victim's Mac has its volume turned up loud enough in the Sound control panel for the bugle to be audible. To do so, choose Control Panels from the Apple menu, then double-click the Sound icon to open its control panel (see figure 7.1).
Figure 7.1 Make sure you can hear the Alert Sound.

Move the Speaker Volume slider until you can clearly hear the beep, then close the control panel.

To temporarily prevent the Mac from launching Playin' Possum, hold down the Shift key during startup until the desktop “Extensions off” message appears. This tells the Mac not to load any extensions and not to launch any of the startup items.

To permanently deinstall Playin' Possum, remove it from the startup items folder and restart.

Modifying Playin' Possum

Playin' Possum comes with a digitized rendition of “Taps” ready to go. But you can change it quite easily if you have the right tools and a little experience. You can create a sound resource with your favorite sound input device—such as the built-in microphones on the newer Macs, or a Macromedia MacRecorder—or use a sound file you obtained from another source.
Replace the Playin' Possum application’s existing snd resource (ID 128) called “The Sound” with your new sound resource. If for some reason your sound-editing utility doesn’t allow you to save your new sound inside Playin’ Possum, you can try transferring the resource into Playin’ Possum with ResEdit or a utility such as SoundMover. Unfortunately, I am not able to provide these utilities with this book, nor can I go into great detail on how to make these modifications because that’s a whole ‘nother subject altogether.

**Compatibility Notes**

*Playin’ Possum requires System 7.*

**Contacting the Programmer**

*Playin’ Possum is copyright 1993, Adam Stein.*

Adam Stein  
Insanely Great Software  
126 Calvert Avenue East  
Edison, NJ 08820-3825  

(201) 549-0590

America Online: AdamStein  
CompuServe: 71140,2051  
Connect: AdamStein
Text Tricks
The seven tricks covered in this section all modify the appearance of text or how it’s entered. Backwords reverses all text, while Moof replaces it with the cry of Clarus the Dogcow. Ümlâút Ömêléttê imparts an international flair by accenting every vowel, and Vanish makes all text completely invisible. If your victim spends much time at the keyboard, you will appreciate the next three tricks. HAL Edit mysteriously replaces text as your victim types, like a real ghostwriter. Mitten Touch-Typist introduces random errors, and NVwls prevents your victim from entering vowels.
With the Backwords extension installed, your victim's Mac displays all text in reverse. The icons appear in their normal places, but with their names displayed backwards. Likewise, windows open normally, but their title bars are reversed. All the menus in the menu bar continue to operate, only it's difficult for your victim to tell what he is doing because the text is flip flopped (see figure 8.1).
Even characters your victim enters into a word processor appear in reverse order as they are typed. But rest assured, nothing really changes permanently. If your victim opens a document when Backwords is installed, it looks as incomprehensible as our nation's tax code. But once you deinstall Backwords, everything returns to normal.

**Installing Backwords**

To install Backwords, just drag it into the System Folder on your victim's startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation.

To deinstall Backwords, remove it from the System Folder and restart. This is somewhat tricky for two reasons. First, the file names appear reversed in the Finder, so you must look for Backword's unique icon of a reversed letter B (it helps if you choose By Icon from the Finder's View menu before installing Backwords). Second, you need to know how to choose Restart from the Finder's Special menu when all the menu names and choices have been reversed. Unless you have made other modifications to the Finder, under System 7 the Special menu is the last one on the right in the menu bar (it's second from the right under System 6), and Restart is the second from the bottom of the Special menu (except on PowerBooks, where it is the third item from the bottom). So choose trateR from the laicePS menu.

**Using Backwords**

Backwords is very effective all by itself, but it can be even more fun if installed at the same time as Vanish, the extension that makes all text disappear. That way, if your victim finds one of the extensions and trashes it, the next time he or she restarts, the other extension is still around to wreak havoc. Pretty nasty, huh?

**Compatibility Notes**

Backwords works under System 6 and System 7.
Contacting the Programmer

Backwards is copyright 1993, Mark Adams.

Mark Adams
11215 Research Boulevard, Apartment 2036
Austin, TX 78759-4177

America Online: MarkA38
AppleLink: Maverick.Sft
With the Moof extension installed, your victim's Mac becomes possessed by the spirit of Clarus the Dogcow, beloved mascot of Mac developers. Everywhere that text normally appears, it is replaced with the word “Moof” stretched to fit the same number of characters as the original word (see figure 9.1).

Even if your victim opens a document and starts typing, all the text appears as “Moof.” However, the text he or she enters is actually preserved in its unmodified form. The victim just needs to disable Moof to see it. Moof doesn’t affect single characters, nor does it alter numbers.

Figure 9.1  Moof is just the thing for cow-crazy computer users.
Installing Moof
To install Moof, just drag it into the System Folder on your victim’s startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then, choose Restart from the Finder’s Special menu to complete the installation.

For added effect, System 7 users may want to copy the Mooo! sound file to the Startup Items folder inside the System Folder. That way when your victim’s Mac finishes the startup process, the first thing they hear is the Mooo! sound effect and then they notice that all the text has been Moofed.

To deinstall Moof, remove it from the System Folder and restart. This is somewhat tricky for two reasons. First, the normal file names don’t appear in the Finder, so you must look for Moof’s unique icon of Clarus the Dogcow (it helps if you choose By Icon from the Finder’s View menu before installing Moof). Second, you need to know how to choose Restart from the Finder’s Special menu when all the menu names and choices have been Moofed. Unless you have made other modifications to the Finder, the Special menu is the last one on the right in the menu bar under System 7 (it’s second from the right under System 6), and Restart is the second from the bottom of the Special menu (except on PowerBooks, where it is the third item from the bottom). Look for the Moofs with the same number of characters as the items you want to choose. In this case, both Restart and Special are seven characters long.

Using Moof
Moof is very effective all by itself, but it can be even more fun if installed at the same time as Ümlâút Ömêléttè, the extension that adds accents to vowels. For the best interaction, make sure Moof loads before Ümlâút Ömêléttè if you are using an extension manager. The results have all the beauty and fluency of post-industrial Czechoslovakian poetry.

Compatibility Notes
Moof works under System 6 and System 7.
Contacting the Programmer

Moof is copyright 1993, Edward Kandrot. Moooo! sound effect from Kaboom!, courtesy of Nova Development Corporation.

Edward Kandrot
c/o Arcane
202 Calvert Drive, Suite 284
Cupertino, CA 95014-3741

America Online: EdwardK4
Internet: Reed@netcom.com
With the Ümlåût Ōmélëttè extension installed, your victim's Mac randomly places diacritical and circumflex marks over every vowel, giving the Mac all the false savoir-faire of a maître d' at an International House of Pancakes in the Midwest. Just about everywhere that text appears, the vowels sport umlauts, cedillas, tildes, carets, and macrons in a bewildering display (see figure 10.1).

Figure 10.1  Even a polyglot will have trouble translating Ümlåût Ōmélëttè.
Even if your victim opens a document and starts typing, all the vowels are immediately transformed into "foreign" characters when, in fact, the text is actually preserved in its unmodified form just as it was entered. Your victim just needs to deinstall Ümläßt Õmêlêtê to see it. But why let your victim off easy? Ask in a condescending tone of voice normally reserved for wine stewards, "What are you, some sort of bilingual illiterate? Don't you know that you can't use an international keyboard on a domestic Mac?"

**Installing Ümläßt Õmêlêtê**

To install Ümläßt Õmêlêtê, drag it into the System Folder on your victim's startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose, Restart from the Finder's Special menu to complete the installation.

To deinstall Ümläßt Õmêlêtê, remove it from the System Folder and restart.

**Using Ümläßt Õmêlêtê**

Ümläßt Õmêlêtê is very effective all by itself, but it can be even more fun if installed at the same time as Moof, the extension that replaces all text with the word "Moof." For the best interaction, make sure Moof loads before Ümläßt Õmêlêtê. The results have all the beauty and fluency of post-industrial Czechoslovakian poetry.

**Compatibility Notes**

Ümläßt Õmêlêtê works under System 6 and System 7.

**Contacting the Programmer**

Ümläßt Õmêlêtê is copyright 1993, Tim Dierks.

Address withheld by request.
With the Vanish extension installed, your victim's Mac no longer displays text. The icons appear in their normal places, but with blank spaces where their names used to be. Likewise, windows open normally, but there's nothing in their title bars. And all the menus in the menu bar operate, only it's extremely difficult to tell what choices are being made because the text is gone (see figure 11.1).

Figure 11.1  Pull a disappearing act with Vanish.
Installing Vanish

To install Vanish, just drag it into the System Folder on your victim’s startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder’s Special menu to complete the installation.

To deinstall Vanish, remove it from the System Folder and restart. This is somewhat tricky for two reasons. First, the file names don’t appear in the Finder, so you must look for Vanish’s unique icon of a letter being erased (it helps if you choose By Icon from the Finder’s View menu before installing Vanish). Second, you need to know how to choose Restart from the Finder’s Special menu when all the menu names and choices are blank. Unless you have made other modifications to the Finder, under System 7 the Special menu is the last one on the right in the menu bar (it’s second from the right under System 6), and Restart is the second from the bottom of the Special menu (except on PowerBooks, where it is the third item from the bottom).

Using Vanish

Vanish is very effective all by itself, but it can be even more fun if installed at the same time as one of the other text tricks in this section. That way, if your victim finds one of the extensions and trashes it, the next time they restart, another extension is lying in wait ready to spring into action.

Compatibility Notes

Vanish works under System 6 and System 7.
Contacting the Programmer

Vanish was written specifically for this book and is copyright 1993, Edward Kandrot. Vanish was inspired by a similar extension called Bob, which was written by Gerrit de Jager of the Netherlands. If the Jagermeister had only been so thoughtful as to have included his full address with his program, I could have used Bob instead. Oh well...

Edward Kandrot
c/o Arcane
202 Calvert Drive, Suite 284
Cupertino, CA 95014-3741

America Online: EdwardK4
Internet: Reed@netcom.com
HAL Edit is an application that creates extensions which hide in the background, waiting for your victim to type a special string of characters that you define. Then the extension automatically replaces this string with a different string of your choosing. You could make your victim's Mac watch for the word "DOS" and replace it with "Dumb Operating System," or wait for your mark to type "Satan" and respond with "Yes, master, you called?" or whatever. I'll leave it up to your fertile imagination to think up other equally clever word pairs. Incidentally, the program was named after the computer in 2001: A Space Odyssey. Duh.

Installing HAL Edit
HAL Edit is an application, and as such doesn't need to go anywhere special on your hard drive. Put it wherever you normally keep applications and utilities.

Using HAL Edit
Double-click the HAL Edit icon to launch the application. Choose New HAL (Command-N) from the File menu to present a standard file-selection dialog box (see figure 12.1).
Figure 12.1 Give HAL extensions any name you like.

Specify a name and location for your HAL extension, then click Save. The program creates a new file on disk, then HAL Edit presents a window with two text fields (see figure 12.2).

Figure 12.2 Tell HAL Edit what should be replaced with what.
In the Replace text field, enter the characters, word, or phrase that you want to
detect and replace. HAL Edit is not case-sensitive, so don’t bother entering upper- and lowercase letters. Also, don’t enter quotation marks unless you really want them to be part of the string. In the With text field, enter the replacement characters, word, or phrase. When you are satisfied with your entries, click OK and HAL Edit saves these two strings in the extension you previously saved to disk.

If you like, repeat these steps to create additional HAL extensions, each one with its own pair of words. Make sure you give each a unique name so you can tell them apart.

If you want to modify an existing extension, choose Open (Command-O) from the File menu. In the standard file-selection dialog box, highlight the extension you want, then click Open. The HAL edit window appears again, allowing you to make desired changes to the Replace and With text fields.

When you are finished creating HAL extensions, choose Quit (Command-Q) from the File menu.

**Installing HAL Extensions**

To install one or more HAL extensions, just drag them into the System Folder on your victim’s startup volume. Under System 7, an alert box appears explaining that the files belong in the Extensions folder. Click OK and let the Finder put them in the right place. Then choose Restart from the Finder’s Special menu to complete the installation.

Now whenever your victim types one of the strings you specified, it’s automatically replaced with a new string. Keep in mind that you can have multiple HAL extensions active simultaneously. Furthermore, HAL extensions see their own and each other’s typing, so interesting interactions are possible. For instance, create a HAL extension to replace a word with itself, so whenever your victim types the word, HAL backs up and types the same word again and again. One last note: HAL extensions see typed text only. They don’t work with text that is pasted into a document from the Clipboard.

To deinstall a HAL extension, remove it from the System Folder and restart.
Compatibility Notes
HAL Edit works under System 6 and System 7.

Contacting the Programmer
HAL Edit is copyright 1987, Kirk Kerekes. HAL Edit was written on a lark, but feedback from users led Kirk to reinvent it as RoboType, a remarkable program used by thousands of Mac folks around the world. RoboType is available as part of The Deal, a $30 utility bundle with nine other useful extensions. All items in The Deal are compatible with System 6.0.7 or later. Contact PaperClip Products for further details or to place your order.

Kirk Kerekes
PaperClip Products
4308 South Peoria Avenue, Suite 763
Tulsa, OK 74105-3922

(800) 497-5508
(918) 749-7417 voice/fax
(918) 744-9796 voice/fax

Bulletin board system: (918) 743-8347
(Connect and wait to download remote module.)
AppleLink: D5378
Mitten Touch-Typist

With the Mitten Touch-Typist extension installed, your victim’s Mac generates random errors whenever your victim types at the keyboard, be it in a word processor, a spreadsheet, or the Finder itself. The frequency of errors is roughly one typo for every 15 keystrokes; just enough to be a pain, but not so frequent as to be obvious. As the name implies, it’s as if your victim is wearing mittens while at the keyboard.

Installing Mitten Touch-Typist

To install Mitten Touch-Typist, drag it into the System Folder on your victim’s startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder’s Special menu to complete the installation.

If successfully loaded, Mitten Touch-Typist’s icon appears during startup. If the icon shows up with a red X across it, then Mitten Touch-Typist didn’t load for some reason.

Mitten Touch-Typist loads into memory the next three times your victim chooses Restart from the Finder’s Special menu or turns on the Mac. Each time it loads, it modifies the Mittens Preference file in the System Folder (or in the Preferences folder under System 7). After the extension has loaded three times, it refuses to load again until you delete the Mittens Preference file. This prevents Mitten Touch-Typist from permanently screwing up the Mac.

To deinstall Mitten Touch-Typist, remove it from the System Folder and restart.
Compatibility Notes
Mitten Touch-Typist works under System 6 and System 7.

Contacting the Programmer
Mitten Touch-Typist is copyright 1993, Marcio Luis Teixeira. If you enjoy this program, be sure to send Marcio a $5 check for a copy of his shareware disk, which contains many other interesting and useful Mac programs. (Please write "Shareware Disk Request" in the memo field of your check).

Marcio Luis Teixeira
P.O. Box 271603
Fort Collins, CO 80527-1603
America Online: MarcioT
With the NVwls extension installed, your victim's keyboard is no longer capable of producing vowels. So say good-bye to A, E, I, O, and U, whether entered as upper- or lower case letters. (Yeah, I know, Y is sometimes considered a vowel, but the programmer decided to cut it some slack.) Unlike Backwords, Moof, Ûmlâû Ómêléttê, and Vanish, which affect the display of text almost everywhere it appears on the Mac, NVwls prohibits the input of vowels. Your victim can open an existing document and everything looks fine, but once your victim starts typing at the keyboard, things get interesting. Or perhaps I should say "ntrstng." In case you haven't figured it out by now, NVwls stands for No Vowels. Get it?

For me, NVwls is payback for all those fruitless hours spent trying to learn French, an impossible task for someone from New Jersey because it seems as if Jean-Louis Gasse and friends stole all the vowels from the Germans, put them in a Cuisinart, then puréed them into one long consonant-free language. My mouth hurts just thinking about French.

**Installing NVwls**
To install NVwls, just drag it into the System Folder on your victim's startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation.

To deinstall NVwls, remove it from the System Folder and restart.
Compatibility Notes

NVwls works under System 6 and System 7.

Contacting the Programmer

NVwls is copyright 1992, Shane D. Looker.

Shane D. Looker
1232 West Kemper Road, Suite 289
Cincinnati, OH 45240-1618

America Online: ASI Shane
Sound Tricks

The eight tricks covered in this section all rely heavily on sound effects. If your victim makes too much noise around a Mac with a microphone, a very angry Austrian named Conan The Librarian demands silence. Or perhaps you prefer driving your victim crazy by simulating a telephone left Off Hook too long. MacBarf is a classic trick that makes puking noises when disks are ejected, and Sneezomatic takes the opposite approach by sneezing loudly and spitting out disks immediately upon insertion. If you really want it to seem like the Mac has caught cold, Sniff randomly plays coughing, sneezing, and sniffing noises in the background. Use Tweety to play annoying bird chirping sound effects. Much less subtle is Sonic Boom, a trick that cracks the Mac’s screen to the sound of shattering glass. And finally, Squeaker causes the Mac to emit tiny noises every time the mouse button is clicked. It’s enough to drive Walt Disney to kill his furry little rodent friend.
Conan The Librarian

Conan The Librarian is an application that listens to the ambient noise picked up by the Mac's microphone. If your victim makes too much noise, a very angry Austrian demands quiet in no uncertain terms. The longer your victim continues making noise, the more annoyed Conan gets, until he finally screams "Shut Up!" at the top of his lungs.

Installing Conan
Drag Conan The Librarian into the Startup Items folder inside your victim's System Folder. Each time your victim turns on the computer or chooses Restart from the Finder's Special menu, the Mac immediately launches the contents of the Startup Items folder when the desktop appears.

Since the names of startup items appear in the menu bar when launched, you can cover your tracks by renaming Conan. Click once on the file name to highlight the name. Wait for the name to be surrounded by a box (indicating that it's ready for editing), then press the Space bar to replace Conan's name with a blank space. Not only does this keep the file name from appearing when the program launches, it also assures that Conan is the first Startup Item launched, because the Mac goes in alphabetical order.

To temporarily prevent the Mac from launching Conan The Librarian, hold down the Shift key during startup until the "Extensions off" message appears. This tells the Mac not to load any extensions and not to launch any of the Startup Items.
Part 3  Sound Tricks

To permanently deinstall Conan The Librarian, start the Mac while holding down the Shift key, then remove the Conan file from the Startup Items folder and restart. This is the only way to quit Conan.

Make sure your victim's Mac has its volume turned up loud enough in the Sound control panel for the shouting to be audible. To do so, choose Control Panels from the Apple menu, then double-click the Sound icon to open its control panel (see figure 15.1).

![Sound Control Panel](image)

**Figure 15.1** Make sure you can hear the Alert Sound.

Move the Speaker Volume slider until you can clearly hear the beep, then close the control panel.

If there are no microphones shown at the bottom of the control panel, Conan won't be able to hear anything. If your victim's Mac has a built-in microphone, it should appear automatically. If using a Macromedia MacRecorder or other third-party microphone, make sure the appropriate driver file is in the System Folder at startup.
Modifying Conan
Conan The Librarian comes with five sound effects built in. You can change them quite easily if you have the right tools and a little experience. Create sound resources with your favorite sound input device—such as the built-in microphones on the newer Macs, or a Macromedia MacRecorder—or use sound files you obtained from another source.

Replace the Conan The Librarian application’s existing snd resources (ID 1000-1004) with your new sound resources. If for some reason your sound editing utility doesn’t allow you to save your new sounds inside Conan The Librarian, you can try transferring the resources into Conan The Librarian with ResEdit or a utility such as SoundMover. Unfortunately, I am not able to provide these utilities with this book, nor can I go into great detail on how to make these modifications because that’s a whole ’nother subject altogether.

Compatibility Notes
Conan The Librarian requires System 7.

Contacting the Programmer
Conan The Librarian is copyright 1992, Neil Day. Arnold Schwarzenegger sound effects from “Kindergarten Cop” are copyrighted and appear courtesy of Ivan Reitman Productions.

Neil Day
312 Wildflower Parklane
Mountain View, CA 94043

AppleLink: NMDay
Off Hook

With the Off Hook extension installed, your victim's Mac simulates the sounds of a telephone left off the hook for too long. Every ten minutes or so, a digitized voice tells your victim "If you'd like to make a call, please hang up and try again. If you need help, hang up and then dial your operator." This repeats once, then that annoying "Beep, beep, beep," off hook alarm plays for about 15 seconds.

Obviously this trick works best if your victim's Mac is next to a phone. However, a nearby phone isn't mandatory because the volume is deliberately set low to make it somewhat difficult to determine from where the sounds are coming. Even if your victim figures out that it's the Mac making the noise, explain that "Sometimes the modem forgets to hang up properly," or that "A network addressing problem can force an individual node into an involuntary off-hook state." Then fiddle with the cables behind the Mac, charge a $75 consulting fee, and scram before Off Hook kicks in again.

Installing Off Hook

To install Off Hook, just drag it into the System Folder on your victim's startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then, choose Restart from the Finder's Special menu to complete the installation.

There's no need to adjust the Sound control panel because Off Hook overrides the Speaker Volume setting.

To deinstall Off Hook, remove it from the System Folder and restart.
Part 3  Sound Tricks

Compatibility Notes
Off Hook works under System 6 and System 7.

Contacting the Programmer
Off Hook was written specifically for this book and is copyright 1993, Kirk Kerekes.

Kirk Kerekes
PaperClip Products
4308 South Peoria Avenue, Suite 763
Tulsa, OK 74105-3922

(800) 497-5508
(918) 749-7417 voice/fax
(918) 744-9796 voice/fax

AppleLink: D5378
Bulletin board system: (918) 743-8347
   (Connect and wait to download remote module.)
With the MacBarf control panel installed, your victim's Mac plays a disgusting vomiting sound whenever your victim ejects a removable disk by dragging it to the Trash, choosing Eject Disk (Command-E) from the Finder' Special menu, choosing Put Away (Command-Y) from the Finder's File menu, or using the Command-Shift-1 or -2 shortcuts to eject floppies. There's not much more to it. Apparently a great deal of people are easily impressed with such scatological humor...after all, how else do you explain the longevity of the “Married...With Children” series on Fox?

Installing MacBarf
To install MacBarf, just drag it into the System Folder on your victim's startup volume. Under System 7, an alert box appears explaining that the file belongs in the Control Panels folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation.

Make sure your victim's Mac has its volume turned up loud enough in the Sound control panel for the barfing to be audible. To do so, open the Sound control panel (see figure 17.1) by double-clicking its icon under System 7, or choosing the Control Panel desk accessory from the Apple menu under System 6.
Part 3  Sound Tricks

Figure 17.1  The Sound control panel looks different under System 6.

Move the Speaker Volume slider until you can clearly hear the beep, then close the control panel.

To deinstall MacBarf, remove it from the System Folder and restart.

Using MacBarf

Open the MacBarf control panel (see figure 17.2) by double-clicking its icon under System 7, or choosing the Control Panel desk accessory from the Apple menu under System 6.

Figure 17.2  You can temporarily turn off MacBarf via its control panel.
To temporarily disable MacBarf, deselect the Play eject sound checkbox. This prevents MacBarf from doing its thing until the next time your victim restarts the Mac. To permanently disable MacBarf, remove it from the System Folder and restart.

Modifying MacBarf
MacBarf comes with the puking sound effect ready to go (incidentally, that's Dr. Macintosh himself, Bob LeVitus, giving his diaphragm a workout and almost spitting up a lung in the process). You can change it quite easily if you have the right tools and a little experience. Create a sound resource with your favorite sound input device—such as the built-in microphones on the newer Macs, or a Macromedia MacRecorder—or use a sound file you obtained from another source.

Replace MacBarf's existing snd resource (ID 128) with your new sound resource. If for some reason your sound-editing utility doesn't allow you to save your new sound inside MacBarf, you can try transferring the resource into MacBarf with ResEdit or a utility such as SoundMover. Unfortunately, I am not able to provide these utilities with this book, nor can I go into great detail on how to make these modifications because that's a whole 'nother subject altogether.

Compatibility Notes
MacBarf requires System 6.0.4 or later.

Contacting the Programmer
MacBarf is copyright 1993, Bob Schumaker.

Bob Schumaker
1596 Carole Way
Redwood City, CA 94061-2776

America Online: BSchumaker
CompuServe: 72227,2103
Internet: Cobblers@netcom.com
With the Sneezy extension installed, whenever your victim inserts a floppy disk into a drive, it's automatically ejected to the sound of a very violent sneeze. No matter how hard your victim tries, it's impossible to mount floppies or overcome the Mac's allergy attack.

**Installing Sneezy**

To install Sneezy, just drag it into the System Folder on your victim's startup volume. Under System 7, an alert box appears, explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then, choose Restart from the Finder's Special menu to complete the installation.

Make sure your victim's Mac has its volume turned up loud enough in the Sound control panel for the sneeze to be audible. To do so, open the Sound control panel (see figure 18.1) by double-clicking its icon under System 7, or choosing the Control Panel desk accessory from the Apple menu under System 6.

Move the Speaker Volume slider until you can clearly hear the beep, then close the control panel.

To deinstall Sneezy, remove it from the System Folder and restart.
Figure 18.1 The Sound control panel looks different under System 6.

Using Sneezomatic
Because Sneezomatic prevents your victim from mounting floppy disks, there's little reason to install it at the same time as MacBarf, which makes puking noises when floppy disks are ejected. The only benefit is that if your victim finds and removes the Sneezomatic extension from their System Folder, then MacBarf is ready to seize control like Alexander Haig in a power vacuum.

Modifying Sneezomatic
Sneezomatic comes with a built-in sneeze sound effect. You can change it quite easily if you have the right tools and a little experience. Create a sound resource with your favorite sound input device—such as the built-in microphones on the newer Macs, or a Macromedia MacRecorder—or use a sound file you obtained from another source.

Replace Sneezomatic's existing snd resource (ID 128) with your new sound resource. If, for some reason, your sound editing utility doesn't allow you to save your new sound inside Sneezomatic, you can try transferring the resource into Sneezomatic with ResEdit, or a utility such as SoundMover. Unfortunately, I am not able to provide these utilities with this book, nor can I go into great detail on how to make these modifications because that's a whole 'nother subject altogether.
Compatibility Notes
Sneezomatic works under System 6 and System 7.

Contacting the Programmer
Sneezomatic was written specifically for this book and is copyright 1993, Marcio Luis Teixeira. If you enjoy this program, be sure to send Marcio a $5 check for a copy of his shareware disk which contains many other interesting and useful Mac programs. (Please write “Shareware Disk Request” in the memo field of your check.)

Marcio Luis Teixeira
P.O. Box 271603
Fort Collins, CO 80527-1603

America Online: MarcioT
With the Sniff extension installed, your victim's Mac catches a cold. The extension randomly plays sniffle- and throat-clearing sounds once every 15 seconds to 3 minutes. The short sniff happens 40 percent of the time, and the squeaky sniff and small cough each happen 30 percent of the time. When your victim demands to know what's going on, tell 'em with all the sincerity you can fake that “The computer must have a virus. Got any Vicks Vapor Rub to smear on the keyboard?”

Installing Sniff
To install Sniff, just drag it into the System folder on your victim’s startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder’s Special menu to complete the installation.

Make sure your victim's Mac has its volume turned up loud enough in the Sound control panel for the sniffs to be audible. To do so, open the Sound control panel (see figure 19.1) by double-clicking its icon under System 7, or choosing the Control Panel desk accessory from the Apple menu under System 6.
Figure 19.1 The Sound control panel looks different under System 6.

Move the Speaker Volume slider until you can clearly hear the beep, then close the control panel.

To deinstall Sniff, remove it from the System folder and restart.

Modifying Sniff
Sniff comes with three sound effects built-in. You can change them quite easily if you have the right tools and a little experience. Create sound resources with your favorite sound input device—such as the built-in microphones on the newer Macs, or a Macromedia MacRecorder—or use sound files you obtained from another source.

Replace the Sniff application's existing snd resources (ID 1-3) with your new sound resources. If for some reason your sound editing utility doesn't allow you to save your new sounds inside Sniff, you can try transferring the resources into Sniff with ResEdit or a utility such as SoundMover. Unfortunately, I am not able to provide these utilities with this book, nor can I go into great detail on how to make these modifications because that's a whole 'nother subject altogether, and who knows, I may want to write a book about that someday.
Compatibility Notes

Sniff requires System 6.0.4 or later.

Contacting the Programmer

Sniff is copyright 1992, Timothy Miller. Tim’s a starving student, so if you like Sniff, send Tim $10, a bag of potato chips, or a postcard from your hometown.

Timothy Miller
4413 Saint Ives Place
Charlotte, NC 28211-3855

America Online: TAMiller
CompuServe: 72531,3563
Internet: TAMiller@pro-charlotte.cts.com
With the Tweety extension installed, your victim’s Mac randomly plays soothing bird sounds in the background while your victim uses his Mac. They may be soothing at first, but after a while your victim will be seething because stopping that damn chirping is impossible. Resist the urge to rub it in by whistling as you work nearby.

Installing Tweety
To install Tweety, just drag it into the System Folder on your victim’s startup volume. An alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder’s Special menu to complete the installation.

If successfully loaded, Tweety’s icon appears during startup. If the icon shows up with a red X across it, then Tweety didn’t load either because of an error, or because the user canceled loading by holding down the Option key.

To deinstall Tweety, remove it from the System Folder and restart.

Make sure your victim’s Mac has its volume turned up loud enough in the Sound control panel for the birds to be audible. To do so, open the Sound control panel (see figure 20.1) by double-clicking its icon.
Move the Speaker Volume slider until you can clearly hear the beep, then close the control panel.

**Modifying Tweety**

Tweety comes with five sound effects built in. You can change them quite easily if you have the right tools and a little experience. Create sound resources with your favorite sound input device—such as the built-in microphones on the newer Macs, or a Macromedia MacRecorder—or use sound files you obtained from another source.

Replace Tweety's existing snd resources (ID 8210-8214) with your new sound resources. If for some reason your sound editing utility doesn't allow you to save your new sounds inside Tweety, you can try transferring the resource into Tweety with ResEdit or a utility such as SoundMover. Unfortunately, I am not able to provide these utilities with this book, nor can I go into great detail on how to make these modifications because that's a whole 'nother subject altogether.
Make sure there is at least one sound in the Tweety extension, otherwise it won't load. You can have any number of sounds, and Tweety loads them all and picks one at random each time it plays. If you add sounds, make sure the System Heap and Locked bits are selected for each sound. Otherwise they won't load properly.

Keep in mind the sounds are loaded into the System Heap at startup. This means that Tweety sets aside enough memory to keep all of its sounds in memory at all times. This shouldn't present a problem unless you fill Tweety with a whole lot of long sound resources, or if your victim's Mac has very little free memory.

You can also change the rate at which Tweety plays sounds using a utility such as ResEdit. The Rate resource (ID 128) contains two values. The first is the minimum number of seconds to wait before playing a sound, and the second is the maximum. Again this resource must have its System Heap and Locked bits selected.

**Compatibility Notes**

Tweety requires System 7.0 or later. If used with PixelFlipper, PixelFlipper must load before Tweety.

**Contacting the Programmer**

Tweety is copyright 1992, Ted Lowery. If you like this program, Ted asks that you send him a postcard of your home town. If you're involved in the Federal Witness Protection program, just send a postcard of a town you wished you lived in.

Ted Lowery  
P.O. Box 30051  
Raleigh, NC 27622-0051

CompuServe: 76350,2613  
Internet: TBL@rock.concert.net
With the Sonic Boom extension installed, whenever your victim's Mac would normally emit a System beep—in response to clicking outside a dialog box, for example—the screen momentarily shatters to the sound of breaking glass (see figure 21.1).

Figure 21.1 Break the sound barrier, and your victim's monitor, with Sonic Boom.
Installing Sonic Boom

To install Sonic Boom, just drag it into the System Folder on your victim's startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder’s Special menu to complete the installation.

For maximum effect, you must change your victim’s Alert Sound so that the sound of breaking glass accompanies the shattering screen. To do so under System 7, drag the Breaking Glass sound file into the System Folder on your victim’s startup volume. An alert box appears explaining that the file belongs in the System file. Click OK and let the Finder put it in the right place.

To install the Breaking Glass sound file under System 6, you need a utility such as Riccardo Ettore’s Sound Mover, Macromedia’s SoundEdit, or Alsoft’s Fkey/Sound Mover. If you don’t install the sound resource directly into the System file, Sonic Boom still works, but your victim hears the normal Alert Sound instead of breaking glass.

Now you must designate the Breaking Glass sound effect as your victim’s Alert Sound, and make sure your victim’s Mac has its volume turned up loud enough in the Sound control panel for it to be audible. To do so, open the Sound control panel (see figure 21.2) by double-clicking its icon under System 7, or choose the Control Panel desk accessory from the Apple menu under System 6.

![Sound control panel](image)

Figure 21.2 The Sound control panel looks different under System 6.
In the Alert Sounds scroll box, click Breaking Glass. Move the Speaker Volume slider until you can clearly hear the sound effect, then close the control panel.

To deinstall Sonic Boom, remove it from the System Folder and restart.

Compatibility Notes
Sonic Boom works under System 6 and System 7.

Contacting the Programmer
Sonic Boom was written specifically for this book and is copyright 1993, Marcio Luis Teixeira. Sonic Boom was inspired by a similar extension called LunarCrack, which was written by an unknown programmer in Kirkwood, Missouri. If you enjoy this program, be sure to send Marcio a $5 check for a copy of his shareware disk which contains many other interesting and useful Mac programs. (Please write "Shareware Disk Request" in the memo field of your check).

Marcio Luis Teixeira
P.O. Box 271603
Fort Collins, CO 80527-1603

America Online: MarcioT
With the Squeaker extension installed, your victim’s Mac squeaks every time the mouse button is pressed. It’s a great trick to play on a computer neophyte. When asked about the noise, tell your victim to be much more gentle when clicking because obviously it’s hurting the tiny mouse that lives inside the pointing device. When your victim gazes at you in disbelief, respond indignantly, “Why do you think they call it a mouse!?”

Installing Squeaker
To install Squeaker, just drag it into the System Folder on your victim’s startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder’s Special menu to complete the installation.

Make sure your victim’s Mac has its volume turned up loud enough in the Sound control panel for the squeaking to be audible. To do so, open the Sound control panel (see figure 22.1) by double-clicking its icon under System 7, or choosing the Control Panel desk accessory from the Apple menu under System 6.
Move the Speaker Volume slider until you can clearly hear the beep, then close the control panel.

To deinstall Squeaker, remove it from the System Folder and restart.

**Modifying Squeaker**

Squeaker comes with one sound effect built-in. You can change it quite easily if you have the right tools and a little experience. Create a sound resource with your favorite sound input device—such as the built-in microphones on the newer Macs, or a Macromedia MacRecorder—or use a sound file you obtained from another source.

Replace Squeaker's existing snd resource (ID 128) with your new sound resource. If for some reason your sound editing utility doesn't allow you to save your new sound inside Squeaker, you can try transferring the resource into Squeaker with ResEdit or a utility such as SoundMover. Unfortunately, I am not able to provide these utilities with this book, nor can I go into great detail on how to make these modifications because that's a whole 'nother subject altogether.
Compatibility Notes
Squeaker requires System 6.0.7 or later.

Contacting the Programmer

Shane D. Looker
1232 West Kemper Road, Suite 289
Cincinnati, OH 45240-1618
America Online: ASI Shane
Menu Tricks

The dynamic duo of Enchanted Menus and MenuHack keeps your victims dazed and confused as they try desperately to make choices from menus that just move around randomly and pop up in the damnedest places.
With the Enchanted Menus extension installed, whenever your victim chooses an item from the menu bar, the menu pops up in a random location instead of directly below the title (see figure 23.1).

![Figure 23.1](image)

*Figure 23.1* Menus have minds of their own with Enchanted Menus, and appear wherever they darn well please.

The menus still function, but to choose an item from the disembodied menu, your victim must move the cursor over the menu while keeping the mouse button depressed.
Installing Enchanted Menus

To install Enchanted Menus, just drag it into the System Folder on your victim's startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation.

To deinstall Enchanted Menus, remove it from the System Folder and restart.

Compatibility Notes

Enchanted Menus works under System 6 and System 7.

Contacting the Programmer

Enchanted Menus is copyright 1988, IMI SoftWare.

Fred D. Reed
IMI SoftWare
P.O. Box 485
Surfside, CA 90743-0485

AppleLink: IMISoftware
CompuServe: 76357,2530
With the MenuHack extension installed, the menus randomly change position whenever your victim tries choosing an item from the menu bar. For instance, your victim tries choosing Open from the File menu, only to have the File menu scoot out of the way to be replaced by the View menu (see figure 24.1).

![MenuHack](image)

**Figure 24.1** Your victims will be lost when MenuHack switches the menu bar around.

The menus still function, but there's no way to know which menu replaces another. As you can imagine, this can be very bewildering. The secret is to keep the mouse button depressed after clicking a menu. The menus move around at first, but they stay put as long as the button is held down, so your victim can choose a command. Oh yeah, the Apple, Balloon Help, and Applications menus never move because they wouldn't function otherwise.

Actually, there are two different versions of MenuHack included with this book. Plain ol' MenuHack operates as just described. MenuHack (Rotate) causes the menus to rotate from left to right in a more predictable fashion. Install whichever one you like best, but don't install them both at the same time; the one that loads first during startup is the only one activated.
Installing MenuHack
To install MenuHack, just drag the desired version into the System Folder on your victim's startup volume. An alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation.

To deinstall MenuHack, remove it from the System Folder and restart.

Compatibility Notes
MenuHack requires System 7 or later.

Contacting the Programmer
MenuHack is copyright 1992, Shane D. Looker.

Shane D. Looker
1232 West Kemper Road, Suite 289
Cincinnati, OH 45240-1618
America Online: ASI Shane
Miscellaneous Tricks

The seven tricks covered in this section are a hodge-podge of devious and demented programs that don’t fit into any convenient pigeon hole. April Fools pretends to erase the hard drive, and Burning Fuse makes shutting down a blast, complete with an exploding bomb. In these days of environmental awareness, Dimwit could be sold as a power saver that slowly dims your victim’s screen to almost complete darkness. Munch devours windows and alert boxes in such big bites it gives the Mac a case of the belches. Sexplosion lures victims with a suggestive icon only to torment them with a playful error alert box upon launching. Sproing brings bungee jumping to the Mac’s cursor, causing it to bounce all over the place at the slightest provocation. And last, but not least by a long shot, a swarm of Termites attacks your victim’s screen with you controlling the little buggers.
April Fools

With the April Fools extension installed, the next time your victim’s Mac needs to display an alert box—such as when an extension is double-clicked—a bomb appears accompanied by the words “Error: Initializing hard disk…” (see figure 25.1).

![Error: Initializing hard disk...](image)

*Figure 25.1* Keep those nitroglycerin pills handy as your victim may have a heart attack when they see this alert box.

After a few tense seconds of hearing the startup volume being accessed, your victim is let in on the fact that it’s all a harmless April Fools’ joke and the name of the programmer is revealed, a guy your victim probably wants to throttle at that point. Then the real alert box message appears, just as if nothing out of the ordinary happened.

After it appears twice, April Fools turns itself off to prevent the fake alert box from appearing again.
Installing April Fools

To install April Fools, just drag it into the System Folder on your victim's startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation.

To deinstall April Fools, remove it from the System Folder and restart.

Compatibility Notes

April Fools works under System 6 and System 7.

Contacting the Programmer

April Fools is copyright 1991, Ron Breger.

Ron Breger
3850 Sheffield Circle
Danville, CA 94506-1260

America Online: RonBreger
With the Burning Fuse extension installed, whenever your victim chooses Shut Down or Restart from the Finder’s Special menu, the Mac plays a brief animation of a bomb with a burning fuse, complete with a cursor that looks like a lit match. When the fuse sputters after reaching the bomb, an explosion is heard and everything proceeds normally (see figure 26.1). Clicking the mouse button or pressing a key skips the animation altogether.

Figures 26.1  Shutting down is a blast with Burning Fuse.

Installing Burning Fuse
To install Burning Fuse, just drag it into the System Folder on your victim’s startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder’s Special menu to complete the installation.

To deinstall Burning Fuse, remove it from the System Folder and restart.
Compatibility Notes
Burning Fuse requires System 4.1 or later.

Contacting the Programmer

Ron Hayter
3691 West 23rd Avenue
Vancouver, BC V6S 1K6
Canada
Dimwit

With the Dimwit extension installed, the screen on your victim's Mac gradually dims to 25 percent of its maximum brightness level after your victim presses a key or clicks the mouse. When the screen becomes noticeably dimmer, your victim is likely to crank up the brightness on the monitor to no avail. No matter what adjustments are made, the monitor reaches rock bottom in about five minutes.

When your victim asks you to see whether the monitor is dying or his eyesight is failing, tell him he needs to adjust the brightness on the monitor. Your victim whines that it was already tried, but you just go about your business of fiddling with the brightness knob as you secretly tap the Caps Lock key, causing the screen to revert to its normal brightness level. "Hmm, it works for me," you say in a snotty tone of voice, "I must have magic hands." If you leave the Caps Lock key depressed, Dimwit leaves the screen alone. If the Caps Lock key is not left locked in the down position, Dimwit starts the slow fade again. This really aggravates your victim because the brightness knob won't work for him as it just did for you. If your victim is a real dimwit, you can probably keep rescuing his Mac all day long.

Installing Dimwit

To install Dimwit, just drag it into the System Folder on your victim's startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation.
Open the Monitors control panel and make sure your victim’s Mac is set
to display colors or grays in any mode except Black & White.

To deinstall Dimwit, remove it from the System Folder and restart.

**Compatibility Notes**

Dimwit requires a color or gray-scale monitor and 32-Bit QuickDraw,
which is present in System 7 and is available as an extension for any
color-capable Mac running System 6.0.5 or later.

**Contacting the Programmer**

Dimwit was written specifically for this book and is copyright 1993,
Scott Fought.

Scott Fought
485 Metzgar Street
Half Moon Bay, CA 94019-2019
With the Munch extension installed, an invisible, but extremely hungry monster with an enormous mouth, slowly eats the windows on your victim's Mac (see figure 28.1). The monster has the appetite of Rush Limbaugh at a pie eating contest to benefit the Republicans Without Yachts Foundation, so it also wolfs down alert boxes and dialog boxes. After finishing a meal, Munch rips a reverberating belch, licks its lips, and waits for another window to be brought forth.

Figure 28. Munch makes a meal of your victims' windows.
Anything that remains visible in a partially-eaten window or box is fully functional. For instance, if undigested buttons appear in alert boxes, they're still clickable. And as long as a window's title bar hasn't been consumed, the tattered window can be dragged around the desktop. However, the monster usually swallows a window's resize box in the lower right corner with its first chomp. The trick to temporarily restoring a window is to click the zoom box in the upper right corner. If the zoom box has been eaten, you can always restore a window by pressing Command-W to close the window, then reopen it as you would normally.

**Installing Munch**

To install Munch, drag it into the System Folder on your victim's startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation.

If successfully loaded, Munch's icon appears during startup. If the icon shows up with a red X across it, then Munch didn't load for some reason.

Make sure your victim's Mac has its volume turned up loud enough in the Sound control panel for the munching and burping to be audible. To do so, open the Sound control panel (see figure 28.2) by double-clicking its icon under System 7, or choosing the Control Panel desk accessory from the Apple menu under System 6.

---

**Figure 28.2** The Sound control panel looks different under System 6.
Move the Speaker Volume slider until you can clearly hear the beep, then close the control panel.

To deinstall Munch, remove it from the System Folder and restart.

**Compatibility Notes**

*Munch works under System 6 and System 7.*

**Contacting the Programmer**

*Munch was written specifically for this book and is copyright 1993, Marcio Luis Teixeira. If you enjoy this program, be sure to send Marcio a $5 check for a copy of his shareware disk which contains many other interesting and useful Mac programs. (Please write “Shareware Disk Request” in the memo field of your check).*

Marcio Luis Teixeira  
P.O. Box 271603  
Fort Collins, CO 80527-1603

America Online: MarcioT
Sexplosion is an application with a suggestive name and an alluring female icon. OK, so sue me. It’s as alluring as you can get with 256 colors in a 32-pixel square. Anyway, put it on your victim’s Mac and wait for curiosity to kill the cat. When your victim double-clicks the icon, instead of a titillating program, an alert box appears displaying a bomb, an error message, and a Restart button (see figure 29.1).

![Figure 29.1](Sorry, a system error occurred.

Restart Resume ID-01)

**Figure 29.1** Curiosity killed the cat, and in this case, it looks like it crashed the Mac, too.

If your victim tries clicking Restart, the button scampers out of the cursor’s grasp (see figure 29.2). The only way to quit is to click the dimmed Resume button.

![Figure 29.2](Sorry, a system error occurred.

Restart Resume ID-01)

**Figure 29.2** Your victims will go crazy trying to click the Restart button that keeps moving away.
Part 5

Miscellaneous Tricks

It's best not to let a naïve user launch Sexplosion when you aren't around because your victim may turn off the Mac in frustration, thereby losing any changes made to unsaved documents.

Installing Sexplosion

Sexplosion is an application, and as such, doesn't need to go anywhere special on your victim's hard drive. However, for best results, put it somewhere that your victim is sure to find it, such as right on the desktop. If you hide it in a folder, make sure you choose By Icon from the Finder's View menu so that the icon is large and noticeable.

Using Sexplosion

Sexplosion doesn't really do anything besides what has already been explained. The only other thing you can do with it is click the bomb icon to present an alert box that shows credits.

Compatibility Notes

Sexplosion works under System 6 and System 7.

Contacting the Programmer

Sexplosion is copyright 1990, Bob Schumaker.

Bob Schumaker
1596 Carole Way
Redwood City, CA 94061-2776

America Online: BSchumaker
CompuServe: 72227,2103
Internet: Cobblers@netcom.com
With the Sproing extension installed, the cursor moves around your victim's screen as if it were attached to a spring. When your victim moves the cursor an inch to the right, it goes three inches right, then snaps back to the left, then bounces around for a bit until it finally settles down. The faster and farther your victim moves the cursor, the longer it takes to come to rest. The only way to avoid this fate is to depress the Caps Lock key.

Installing Sproing
To install Sproing, just drag it into the System Folder on your victim's startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation.

To deinstall Sproing, remove it from the System Folder and restart.

Compatibility Notes
Sproing works under System 6 and System 7.
Contacting the Programmer

Sproing is copyright 1990, Scott Armitage. It won the grand prize in America Online's Best Programmer's Hack contest in October 1990.

Scott Armitage
4580 Eastwood Road
Minnetonka, MN 55345-2411

America Online: SArmitage
With the Termites control panel installed, your victim's Mac becomes infested with tiny termites that randomly eat their way through everything they encounter on screen (see figure 31.1). This is the only program I know of that's loaded with bugs on purpose. As a proud new owner of a wood-frame home, this is one of the scariest tricks in the book for me.

**Figure 31.1** Termites infest your victim's Mac, eating everything they can.

The really cool thing is that Termites doesn't affect other programs, so if your victim continues working, the Mac functions correctly. But if you let Termites run long enough, your victim will find it almost impossible to recognize the screen because those suckers have an insatiable appetite and keep eating no matter what.
When your victim calls you over to the Mac to show you what's wrong, blame the infestation on your victim and demand to know whether he's been running any "buggy" programs lately.

**Installing Termites**

To install Termites, just drag it into the System Folder on your victim's startup volume. Under System 7, an alert box appears explaining that the file belongs in the Control Panels folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation.

To deinstall Termites, remove it from the System Folder and restart.

**Using Termites**

Termites is ready to go once installed, but there are a number of parameters you can change to make it work the way you like. Experiment with different settings on your own Mac until you find values that suit your tastes, then install the control panel on your victim's Mac.

Open the Termites control panel (see figure 31.2) by double-clicking its icon under System 7, or choosing the Control Panel desk accessory from the Apple menu under System 6.

![Termites Control Panel](image)

*Figure 31.2 Termites was written specifically for this book.*

After you've been suitably impressed with the copyright notice and title artwork, click Change Settings to present a dialog box in which you can specify a number of different parameters that affect the action of the vermin (see figure 31.3).
Figure 31.3  All of Termites' settings can be changed via the control panel.

Click one of the radio buttons to specify whether you want white trails with black termites, or vice versa.

In the Termite speed text box, enter a number (1-100) that determines how fast the termites move. The fastest setting is 1 and results in bugs blasting around the screen as if they just inhaled an entire Pixy Stix and washed it down with a cup of espresso.

In the next text box, enter the maximum number (1-100) of termites that should appear on screen at any one time. They don't all appear immediately, but once spawned, a termite remains on screen eating merrily away until it reaches the edge of the main monitor, at which point it turns around and continues its pixel picnic. A swarm of termites can do more damage more quickly, but the Mac slows down when a lot of pests are on screen. A single termite is particularly effective for convincing far-sighted victims that there's a real live bug gnawing on the phosphors inside the picture tube.

In the Seconds before infestation text box, enter the number of seconds (1-180) that should elapse from the time the control panel loads until the first termite appears. If you enter too low a number, the termites appear during the startup process, a dead giveaway that the infestation is the cause of an extension or control panel. Once the first termite appears, it's only a matter of time before there's another, and another, and another, and another, up to the maximum specified in the previous text box.

In the last text box, enter a number (4-72) that determines the movement of the termites. The total number of degrees in a circle (360) is divided by this number to obtain the maximum turning angle that a termite can execute. Higher values result in termites that move smoothly, and lower values cause more erratic behavior. For best results, enter values which divides into 360 evenly (4, 5, 6, 8, 9, 10, 12, 15, 18, 20, 24, 30, 36, 40, 45, 60, or 72).
After entering your choices, click Cancel to close this dialog box without making changes, or click Save to update Termites with the new settings. If you entered any invalid values, they are automatically changed to the minimum or maximum when you click Save. Close the control panel itself by clicking its close box in the upper left corner, or pressing Command-W. Your changes don’t take effect until the next time your victim restarts the Mac.

**Compatibility Notes**

*Terrorite works under System 6 and System 7.*

**Contacting the Programmer**

*Terrorite was written specifically for this book and is copyright 1993, Andrew Welch. Icon courtesy of Dave Schutz of Alikchi Graphics.*

Andrew Welch  
Ambrosia  
P.O. Box 23140  
Rochester, NY 14692-3140

(716) 427-2577  
(716) 475-9289 fax

America Online: AmbrosiaSW  
AppleLink: Ambrosia.SW  
CompuServe: 73424,1226
Network Tricks

The last two tricks covered in this section don't require networked Macs, but it's not nearly as much fun fooling yourself as it is torturing your victims from afar. Think of these as computerized equivalents of flushing the toilet to scald that special someone in your life who just so happens to be taking a shower elsewhere in the house. With NetDino you can set an animated dinosaur on a screaming rampage across the screens of everybody connected to the network. And Radiation lets you reach out across the network to make an alert box appear on your victim's screen with whatever messages you want. The more bizarre, the better.
With the NetDino extension installed on a group of networked Macs, you can inflict a rampaging dinosaur on your coworkers or schoolmates (see figure 32.1). If you thought Jurassic Park was cool, you ain't seen nothin' yet.

Figure 32.1  NetDino lets out a ferocious roar as it stomps across the screen.
Installing NetDino

Install the NetDino extension on as many networked Macs as possible. To install NetDino on a Mac, just drag it into the System Folder on your victim's startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation.

Make sure your victim's Mac has its volume turned up loud enough in the Sound control panel for the roaring dino to be audible. To do so, open the Sound control panel (see figure 32.2) by double-clicking its icon under System 7, or choosing the Control Panel accessory from the Apple menu under System 6.

Figure 32.2  The Sound control panel looks different under System 6.

Move the Speaker Volume slider until you can clearly hear the beep, then close the control panel.

Repeat this process with as many networked Macs as you can manage without getting caught.

To deinstall NetDino, remove it from the System Folder and restart.
Using NetDino

Once NetDino has been installed on a number of networked Macs, launch StartDino on your Mac by double-clicking its icon.

In the dialog box that appears (see figure 32.3), choose a network zone from the left-hand scroll box (if you don’t have zones, click the asterisk that appears instead).

![StartDino dialog box](image)

**Figure 32.3** You must tell StartDino where to start.

Then choose a machine name from the right-hand scroll box. Now click Dinosize, and a rampaging dinosaur stomps across that Mac’s screen, screaming at the top of its lungs. When it walks off the right-hand edge of the screen, it moves on to the next Mac on the network, and like the Energizer Bunny, “It keeps going and going and...” unless one of your victims keeps the mouse button depressed as the dino exits the screen.

**Compatibility Notes**

NetDino works under System 6.0.5 and later, including System 7. To work under System 6.0.5, the victim’s Mac must have the latest version of 32-bit QuickDraw and an 8-bit video card, otherwise the dinosaur doesn’t appear. However, you don’t need color to run StartDino.
Contacting the Programmer


Address withheld by request.
Radiation & Trigger are a pair of fun programs which enable you to send mysterious error messages to other users across networks and have those messages appear as alert boxes on your victim's Mac screen.

These programs were originally designed as a practical joke on software beta testers who would diligently write down every error that appeared on their screens, until the errors became so frequent and absurd that they'd get that "Candid Camera" kind of feeling, and the joke would be revealed.

These programs got their names when Radiation was a one-trick pony. Originally, Radiation just popped up a single warning (the default "Radiation Shield Failure" you still get in Trigger's window) on the victim's screen. When the programs got more sophisticated, programmer Peter Vanags was too lazy to change their names and icons to something more appropriate.

**Installing Radiation**

The Radiation extension is the receiver which patiently sits around in the background until it's time to display an alert box. These alert boxes come out of nowhere, and look normal and convincing enough that your victim thinks the active program created the error message.

To install Radiation, just drag it into the System folder on your victim's startup volume. An alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation.
To deinstall Radiation, remove it from the System folder and restart.

Before leaving your victim's Mac, choose Control Panels from the Apple menu. Then double-click the Sharing Setup control panel so that you can turn on Program Linking (see figure 33.1).

**Figure 33.1** Program Linking must be turned on for Radiation to work.

If it isn't already on, click Start to enable Program Linking (it may take a moment to start up). This makes the victim's Mac eligible to receive messages across the network. Click the close box or press Command-W to close the Sharing Setup control panel.

Double-click the Users & Groups control panel, then Double-click the <Guest> icon so that you can change the privileges assigned to unregistered users (see figure 33.2).
Select the Program Linking checkbox. Click the close box or press Command-W to close the window. If asked, click Save to make sure the changes for the <Guest> user are saved to disk.

To complete the installation, choose Restart from the Finder's Special menu.

Repeat these procedures for any other networked MacOSs to which you want to send messages.

### Installing Trigger
Trigger is an application, and as such, it doesn't need to go anywhere special on your hard drive. Put it wherever you normally keep applications and utilities.

### Using Trigger
Trigger is the sender. You type a message in the window of this simple application and seconds later the message appears in an alert box on your victim’s screen. You can send error alert boxes to yourself (a good idea when initially testing these programs), but it’s not nearly as fun as sending them to other unsuspecting people.

Launch Trigger by double-clicking its icon.
The Alert Sender window appears containing the following default message: “The radiation shield on your Macintosh has failed. Please step back 5 feet.” The Send Alert button may be dimmed temporarily, but it becomes active within seconds (see figure 33.3).

![Alert Sender](image)

**Figure 33.3** You enter whatever message you want in Trigger’s main window.

If this isn’t the message you want to send, highlight the text and enter a replacement with up to six lines of 45 characters each. The radiation warning has actually frightened some naïve users, who have run from their desks in a state of panic. Keep your victim’s Mac experience in mind when composing messages, and be merciful. Start by putting up rather convincing errors (referring to things that tend to blow up a lot—every network has its own most popular software gremlins). Then create errors that get progressively sillier until you finally arrive at something completely absurd, such as the original radiation warning. Try not to laugh out loud as your victim gets more and more mystified by these errors.

Once you have entered a satisfactory message, click Send Alert to present a dialog box (see figure 33.4).
Find a recipient for your alert message:

Macintoshes

Mac IIci
PowerBook

Receivers

Alert Receiver

The left-hand scroll box shows the names of those Macs on the network that are turned on. (If nothing appears, choose Chooser from the Apple menu and make sure AppleTalk is turned on. If there's still nothing, perhaps your victim's Mac isn't turned on or logged onto the network.) Click the name of your victim's Mac. If Radiation is properly installed on their Mac, the right-hand scroll box should display Alert Receiver, which is the name given to Radiation. (Trigger should never put any ineligible receivers in the right-hand scroll box, so you needn't worry about sending an error alert to an application that doesn't know what to do with it.) Select Alert Receiver, then click OK to send your message.

In a few seconds your message appears as an alert box on your victim's Mac (see figure 33.5).
The radiation shield on your Macintosh has failed. Please step back 5 feet.

Figure 33.5 Your message looks just like a real alert box.

No matter what the message, nothing harmful really happens to your victim’s Mac. A simple click dismisses the alert box. But by then, you may have already sent your victim another message just to keep things interesting...

Compatibility Notes
Radiation & Trigger require System 7. Radiation is compatible with LocalTalk and Ethernet networks, and also works with AppleTalk Remote Access.

Contacting the Programmer
Radiation & Trigger are copyright 1993, Peter Vanags. All Peter asks is that you send him a really funny story about how you used this software to mess with someone’s mind.

Peter Vanags
Electronic Ink (aka Ace Novelty Software)
72 Caselli Avenue
San Francisco, CA 94114-2319

AppleLink: Ink.Link
CompuServe: 70401,3202
Appendices
This chapter reiterates some important information regarding common problems you might experience while using the programs on the disk.

Help! I’ve installed a trick and now I can’t remember how to deinstall it.
With a few exceptions, all of the tricks can be temporarily disabled by restarting and holding down the Shift key during startup under System 7, or the Command key under System 6. Then to permanently deinstall, remove the trick from the System file and drag it into the Trash.

When I’m ready to deinstall, I can’t seem to find the tricks.
If you followed the instructions correctly, under System 6 control panels and extensions alike are just floating around right inside the System Folder. Under System 7, they are in the Control Panels folder and Extensions folder, respectively, which both reside inside the System Folder itself. Likewise, applications which launch immediately at startup are in the Startup Items folder. If you still can’t find the files, under System 7 choose Find (Command-F) from the Finder’s File menu and in the dialog box which appears, enter the name of the file for which you are looking.

I’d like to install these tricks, but I’m afraid of contaminating my victim’s Macs with viruses.
All of the files included in this book have been scanned with the most current versions of five different virus detection utilities. According to these utilities and the assurances of the programmers, these files are free from known viruses and Trojan Horses. However, some anti-viral utilities may prevent you from installing
these tricks as described. That’s not because these tricks contain viruses, it’s just that these utilities are designed to prevent all unauthorized installations. So wherever possible, disable these utilities before attempting to install the tricks on your victim’s Mac. Furthermore, I recommend that you write-protect the original disk and use it only to make a backup from which you actually install the files. That way it can’t inadvertently pick up a virus.

I think I have an INIT or extension conflict. How do I resolve this?
The easiest way to resolve a conflict is to load only one trick at a time and be sure that it’s the only non-essential control panel or extension installed. This is easy to do if your victim uses an extension manager which controls files that load upon startup. Another common solution to extension conflicts is to change the normal loading order of extensions and control panels, since some tricks work best if they load at a particular time, such as first or last. If your victim doesn’t use an extension manager, create a new folder and then drag all non-essential extensions and control panels into this folder. This keeps them from loading at startup. When you are done playing your trick, put the stuff in this new folder back where it came from.

How do I keep my victims from finding the trick programs right away?
Most of these programs have rather obvious names and icons that are dead giveaways to anyone searching for the cause of erratic behavior. After installing a program on your victim’s Mac, you can give these files more innocent names, such as Word Pref or Scrapbook Catalog. Under System 6, click the file name until it’s highlighted (under System 7, wait for a box to appear around the name), then type an innocuous new name. Since most people don’t really know exactly what belongs in their System Folder, this is the easiest way to throw your victim off your scent. Just remember any new names you assign so that you can deinstall the tricks when the time comes.

Another great trick is to change a program’s icon to something generic and harmless looking. Doing so under System 6 is a little difficult and requires a utility such as Apple’s ResEdit. However, it’s a breeze with the Finder in System 7. Simply click once on a file whose icon you want to appropriate, then choose Get Info (Command-I) from the File menu. In the window that appears, click the icon in the upper left so that it’s surrounded by a box. Choose Copy (Command-C) from the Edit menu to place a copy of the icon on the Clipboard. Close this window (Command-W) and then open the Get Info window for the trick you are trying to disguise. Click the trick’s icon to select it, then choose Paste (Command-V) from the Edit menu to replace the trick’s icon with the one you copied to the Clipboard earlier. If you ever want to revert back to the old icon, just highlight the icon in the Get Info window and press Delete.
Is there any way to hide the tricks so that they'll be almost impossible for my victim to discover?
The best way to keep your victim from stumbling upon a trick is to make it invisible altogether. The Mac relies on a number of invisible files all the time, but there's no legitimate reason for most users to make files invisible, so the Finder doesn't provide an easy way to accomplish this task. You could flip a file's Invisible bit with a program such as Apple's ResEdit or Symantec's Norton Utilities, but as a precaution against viruses, the Mac won't load invisible extensions. No sweat. I've devised a cool work-around.

Click once on the file name to highlight the trick's name (under System 7, wait for the name to be surrounded by a box), then press Option-space to replace the entire name with a blank space. That takes care of hiding the name. Now for the icon. Using the System 7 tip described earlier, replace the trick's icon with a copy of the blank icon that I've provided on disk. Simply click once on the Blank Icon file, then choose Get Info from the File menu. In the window that appears, click the invisible icon in the upper left so that it's surrounded by a box. Choose Copy (Command-C) from the Edit menu to place a copy of the icon on the Clipboard. Close this window (Command-W) and then open the Get Info window for the trick you are trying to hide. Click the trick's icon to select it, then choose Paste (Command-V) from the Edit menu to replace the trick's icon with the invisible one you just copied to the Clipboard. If you ever want to revert back to the old icon, just highlight the icon in the Get Info window and press Delete.

Now your trick is almost completely invisible. I say almost because it shows up as a blank line when you view the contents of folders by Name, Size, or Kind. Also, its icon may appear during the startup process. Still, as far as most users are concerned, it'll be harder to find than that Waldo goofball.

I can't get a particular trick to work as described.
All the tricks have been extensively tested on a variety of Macs running System 6.0.8 and System 7.1, but these programs are provided "as is," which means they may or may not work correctly on your victim's particular Macintosh configuration. When in doubt, please consult the "Compatibility Notes" section in each chapter, disable all non-essential extensions, and upgrade to the most current System software.

Who can I call for technical support?
Sorry! There is no technical support line to call. But then, the programs in this book are so limited in what they do that it's unlikely you'll have many questions about how to use them. Either they work as described, or they don't. If you experience a problem using a particular trick, your best bet is to notify the programmer.
using the information listed in the "Contacting the Programmer" section at the end of each chapter. Also, although I can't promise to provide a fix if a program doesn't work as described, I sincerely want to know if you have problems. Please specify the type of Mac being used, the version of the System software, and a brief description of what went wrong.

I installed the programs, but they don't have the same icons that are shown in the book.

If you want your Mac to display the custom icons pictured in this book, you may have to rebuild your Desktop. The tricks are operational as is, but it's a good idea to rebuild the Desktop periodically for preventative maintenance whenever generic icons appear where they shouldn't. To rebuild the Desktop, start your Mac normally, but hold down the Command-Option keys until the Finder asks if you really want to rebuild the Desktop. You do, so click OK. If you have more than one disk, click OK as the Finder asks about rebuilding the Desktop on each. The time it takes to rebuild the Desktop depends on the speed of the drive and the size of the disk. When done, the Finder should no longer show generic icons for any files which have their own icons. Also, you may notice somewhat faster response time when starting up your Mac or quitting programs. The only drawback to rebuilding your Desktop is that you lose any Comments you may have entered into files' Get Info windows. Since few people use this feature anyway, it's usually not a concern.
The enclosed 800k, 3.5-inch disk contains all 33 programs covered in this book in a compressed archive. Before you can install any of these tricks, you must first unstuff this archive. To do so, turn on your Mac and when the Finder's desktop appears, insert the enclosed disk in an empty drive. Double-click the disk icon to open its window, then double-click the Programs sea icon to launch StuffIt Lite. At the splash screen, click Continue to present a dialog box in which you can specify a name and location for the Programs folder. Pick a hard drive with at least 1.1M of free space, then click Save. An alert box shows the progress as StuffIt Lite unstuffs the files in the archive. If all goes well, click Quit after the alert box announces that the installation was successful and all the files shown in the inside front cover should appear in the Programs folder.

Once these files have been unstuffed, follow the detailed directions in each program's chapter for installing the individual files where they belong on your victim's Mac. In general, all applications should be placed in the Startup Items folder under System 7 (or as a Startup Item with MultiFinder under System 6), whereas control panels and extensions should be copied into the System folder for proper use. Usually you must choose Restart from the Finder's Special menu to complete the installation.

After installing the tricks as described, they may have generic icons. If you want your Mac to display the custom icons pictured in this book, you must rebuild your Desktop. The tricks are operational as is, but it's a good idea to rebuild the Desktop periodically for preventative maintenance whenever generic icons appear where
they shouldn't. To rebuild the Desktop, start your Mac normally, but hold down the
Command-Option keys until the Finder asks if you really want to rebuild the
Desktop. You do, so click OK. If you have more than one disk, click OK as the
Finder asks about rebuilding the Desktop on each. The time it takes to rebuild the
Desktop depends on the speed of the drive and the size of the disk. When done, the
Finder should no longer show generic icons for any files which have their own
icons. Also, you may notice somewhat faster response time when starting up your
Mac or quitting programs. The only drawback to rebuilding your Desktop is that you
lose any Comments you may have entered into files' Get Info windows. Since few
people use this feature anyway, it's usually not a concern.
April Fools

When your victim's Mac needs to display an alert box, a bomb appears instead, accompanied by the words "Error: Initializing hard disk..." and the sound of the hard disk being accessed. But it's all a harmless prank. Page 97

Backwords

Displays all text in reverse. Icons appear with their names displayed backwards. Likewise, windows open normally, but their title bars are reversed. And all menus operate, only it's difficult to tell what's what because the text is flip-flopped. Page 35.

BrokaMac

Simulates a serious hardware failure on your victim's monitor by creating a double-vision image of the Finder's desktop while squealing like a member of Congress about to lose a district military base. Page 17.

Burning Fuse

Whenever your victim chooses Shut Down or Restart from the Finder's Special menu, the Mac plays a brief animation of a bomb with a burning fuse, complete with a cursor that looks like a lit match. When the fuse reaches the bomb, an explosion is heard and everything proceeds normally. Page 99.
Conan The Librarian
When the sound level detected by a microphone exceeds a certain volume level, a very angry Austrian screams at your victim to be quiet. Page 59.

Dimwit
With the Dimwit extension installed, the screen on your victim’s Mac gradually dims to 25 percent of its maximum brightness level. Cranking up the brightness knob is fruitless. No matter what adjustments are made, the monitor reaches rock bottom in about five minutes. Page 101.

DOS sHELL
Your victim’s familiar “Welcome to Macintosh” startup greeting is replaced by a black screen and the infamous blinking “C:\>”, just as if the friendly Mac had somehow transformed itself into one of those awful IBM PCs. Page 13.

Enchanted Menus
Whenever your victim chooses an item from the menu bar, the menu pops up in a random location instead of directly below the title. Best of all, the menus are still functional. Page 91.

FlyPaper
Makes the Finder’s desktop act like a piece of flypaper which sticks to the cursor. No matter how hard your victim wiggles the mouse to shake the screen free of the cursor, the entire desktop hangs on with the tenacity of a pitbull terrier munching on a mailman. Page 21.

HAL Edit
Hides in the background waiting for your victim to type a special string of characters that you define. Then it automatically replaces this string with a different string of your choosing. Try replacing “Satan” with “Yes, master, you called?” Page 49.
MacBarf
Makes your victim's Mac play a disgusting vomiting sound when it ejects a disk. Page 65.

MenuHack
Whenever your victim tries clicking a menu, all of the menus switch around, either at random or in rotation. Page 93.

Mitors
Each time your victim's Mac goes through the startup process, the main monitor loses one pixel from its height or width, gradually shrinking the screen. Page 15.

Mitten Touch-Typist
Randomly generates mistakes as your victim types. As the name implies, it's as if your victim is wearing mittens while at the keyboard. Page 53.

Moof
Replaces all text with the word Moof, in homage to Clarus the Dogcow, mascot of Mac developers. Beats stepping in a Dogcow-pie with your bare feet. Page 39.

Munch
Windows on your victim's Mac are slowly eaten by an invisible, but extremely hungry monster with an enormous mouth. No, it's not Rush Limbaugh, but an incredible simulation. Page 103.

NetDino & StartDino
This pair of programs enables you to inflict a rampaging dinosaur on your networked coworkers or schoolmates. Page 117.
NVwls
Prevents your victim from entering vowels on the keyboard, resulting in a bizarre-looking mish-mash of consonants that resembles programming code. Page 55.

Off Hook
Every ten minutes your victim’s Mac goes “off hook” and a digitized voice tells your victim “If you’d like to make a call, please hang up and try again. If you need help, hang up and then dial your operator.” Page 63.

Playin’ Possum
Whenever your victim turns on his Mac, it sounds “Taps” and then plays dead by shutting down. Page 29.

Radiation & Trigger
This pair of programs enables you to send mysterious error messages to other users across networks and have those messages appear as alert boxes on your victims’ screens. Page 121.

Sexplosion
Double-click this application’s alluring female icon and instead of an explicitly sexy program, your victim is presented with an alert box displaying a bomb, an error message, and a Restart button. If your victim tries clicking Restart, the button scampers out of the cursor’s grasp. Page 107.

Sneezomatic
Whenever your victim inserts a floppy disk into a drive, it’s automatically ejected to the sound of a very violent sneeze. Page 69.
Sniff

Gives your victim’s Mac a cold by randomly playing snifflie and throat-clearing sounds. Page 73.

Solvent

Makes the Finder’s desktop melt away like an ice cube in hell or tax dollars in Washington, D.C. Page 25.

Sonic Boom

Whenever your victim does anything that causes a system beep, the screen momentarily shatters with random cracks and the sound of breaking glass. Page 81.

Sproing

Makes the cursor move around your victim’s screen as if it were attached to a spring. Elegant in its simplicity, but very annoying. Page 109.

Squeaker

Your victim’s Mac makes an annoying squeaking sound every time the mouse button is pressed. Page 85.

StartupScreens

Greet your victim with one of two humorous images that simulate a Mac in distress. Page 9.

Termites

Tiny termites randomly eat their way across your victim’s screen. Better than an ant farm because you control a variety of settings. Page 111.
Tweety
Plays bird sound effects at random intervals in the background. Your victim will wonder if a bird somehow got trapped in the house or office. Page 77.

Ümlâüt Ömêlêttê
Your victim’s Mac randomly places diacritical and circumflex marks over every vowel, giving the Mac all the false savoir-faire of a maître d’ at an International House of Pancakes in the Midwest. Page 43.

Vanish
Your victim’s Mac no longer displays text anywhere. Icons appear with blank spaces below their names and windows open, but there’s nothing in their title bars because all the text is completely gone. Page 45.
Index

A

Ace Novelty Software, 126
Adams, Mark, 37
Alert Sender window, Trigger, 124
Alikchi Graphics, 87, 114
Ambrosia, 114
April Fools, 97-98, 135
archived files, decompressing, 133-134
Armitage, Scott, 110
Axis Graphics, 120

B

Backwords, 35-36, 135
bird sound effects, 77
bomb/fuse display, 99
bombing, 107-108
    simulations, 97
breaking glass sound effects, 81
Breger, Ron, 98
BrokaMac, 17-20, 135
Broken Mac StartupScreen, 9
Burning Fuse, 99, 135
burping, 103
By Icon command (View menu), 40, 46

C

Caps Lock key
    deactivating Sproing, 109
    Dimwit, reversing, 101
Command key, 129

compatibility

April Fools, 98
Backwords, 36
Burning Fuse, 100
Conan The Librarian, 61
Dimwit, 102
Enchanted Menus, 92
FlyPaper, 24
HAL Edit, 52
MacBarf, 67
MenuHack, 94
Minitors, 16
Mitten Touch-Typist, 54
Moof, 40
Munch, 105
NetDino, 119
NVwlsl, 56
OffHook, 64
Playin’ Possum, 31
Radiation, 126
Sexplosion, 108
Sneezomatic, 71
Solvent, 27
StartupScreens, 11
Termites, 114
Trigger, 126
Tweety, 79
Ümlaut Ômeletê, 44
Conan The Librarian, 59-61, 136
conflicts, resolving, 130
cycle panels, MiniScreen, 16
coughing, 73
cursors, spring-simulating, 109
Cyberite Systems, 120
Davison, Morgan, 16
Day, Neil, 61
decompressing, archived files, 133-134
deinstalling, tricks, 129
Desktop, rebuilding, 25, 132-133
diacritical marks, adding, 44
Dierks, Tim, 44
dimming, screen, 101
Dimwit, 101-102, 136
dinosaurs, 117-120
disabling
BrokaMac, 19
MacBarf, 67
temporary, 129
disappearing text, 45
disguising trick programs, 130
disks, mounting prevention, 69-70
DOS sHELL, 13-14, 136

**Electronic Ink (aka Ace Novelty Software), 126**
Enchanted Menus, 91-92, 136
Englund, N. Jonas, 11
error messages, sending across network, 121
ers, typing, 53
extension conflicts, 130
extensions
creating/replacing, 49-51
HAL, installing, 51-52
fading, screen, 101
faux bombing, 97
files, installing, 133-134
Fkey/Sound Mover (Alsoft), 82
floppy disks, mounting prevention, 69-70
FlyPaper, 21-24, 136
formats, PICT, 11
Fought, Scott, 102

**HAL Edit, 49-51, 136**
Hayter, Ron, 100
hiding, tricks, 131
icons
custom, displaying, 132-133
modifying, 130
IMI SoftWare, 92
INIT conflicts, 130
input of vowels, prohibiting, 55
Insanely Great Software, 31
installing
April Fools, 98
Backwords, 36
BrokaMac, 18-20
Burning Fuse, 99
Conan The Librarian, 59-60
Dimwit, 101-102
DOS sHELL, 14
Enchanted Menus, 92
extensions (HAL), 51-52
files, 133-134
FlyPaper, 22-24
HAL Edit, 49
MacBarf, 65-66
MenuHack, 94
Minitors, 15
Mitten Touch-Typist, 53
Moof, 40
Munch, 104-105
NetDino, 118
NVwls, 55
Off Hook, 63
Playin’ Possum, 29-30
Radiation, 121-123
Sexplosion, 108
Sneezeomatic, 69-71
Sniff, 73-74
Solvent, 26-27
Sonic Boom, 82-83
Sproing, 109
Squeaker, 85-86
StartupScreens, 10
Termites, 112
Trigger, 123
Tweety, 77-78
Ümlâüt Ömélétè, 44
Vanish, 46

K-L

Kandrot, Edward, 41, 47
Kerekes, Kirk, 20, 24, 52, 64
launching
StartDino, 119
StuffIt Lite, 133
LeVitus, Bob, 67
Looker, Shane D., 56, 87, 94
Lowery, Ted, 79
LunarCrack, 83

M

Mac, shutting down (Playin' Possum), 29
MacBarf, 65-67, 137
Macs, networked
NetDino, 117-120
sending error messages across, 121
malfunctioning tricks, 131
marks, diacritical, 44
Melting Mac StartupScreen, 10
MenuHack, 93-94, 137
menus
elusive, 91
random position changes, 93
messages, error, 121
Miller, Timothy, 75
MiniScreen control panel, 16
Minitors, 15, 137
Mitten Touch-Typist, 53, 137
Moof, 39-40, 137
mouse squeaking sound effect, 85
movements, termite (controlling), 113
Munch, 103-105, 137

N-O

NetDino, 117-118, 137
networked Macs
NetDino, 117-120
sending error messages across, 121
Nova Development Corporation, 100
NVwls, 55, 138
Off Hook, 63, 138

P-Q

PaperClip Products, 24, 52, 64
PICT format, 11
Playin' Possum
Playin' Possum, 29-31, 138
programs, disguising, 130
quitting, BrokaMac, 17-18

R

Radiation, 121-123, 138
rates of sound play, Tweety, 79
rebuilding Desktop, 132-133
Reed, Fred D., 92
renaming
BrokaMac, 18
Conan The Librarian, 59
Playin' Possum, 29
Solvent, 26
tricks, 130
Restart button, elusive, 107
Restart command (Special menu), locating, 36
restoring munched windows, 104
RoboType, 52
rotate option (MenuHack), 93

S

Schumaker, Bob, 68, 108
Schutz, Dave, 87, 114
screens
dimming, 101
eating away by termites, 111-112
shattering, 81
shrinking, 15
Sexplosion, 107-108, 138
Shift key, disabling tricks, 129
shutting down with bomb/fuse display, 99
Simmons, Mark, 120
Simon, Phill, 120
Sneezomatic, 69-71, 138
Sneeze, 73-74, 139
Solvent, 25-27, 139
Sonic Boom, 81, 139
sound effects
  birds, 77
  breaking glass, 81
  burping, 103
  mouse squeaking, 85
  sneezing, 69
  sniffing, 73
  telephone off the hook, 63
  vomiting, 65
Sound Mover (Riccardo Etore), 82
SoundEdit (Macromedia), 82
sounds, modifying
  Conan The Librarian, 61
  Playin' Possum, 31
Special menu, locating, 36, 40
speeds, Termites, 113
spring-simulating cursors, 109
Sproing, 109, 139
Squeaker, 85-86, 139
StartDino, 137
  launching, 119
StartupScreens, 9-11, 139
Stein, Adam, 31
StuffIt Lite, launching, 133
System 6 installations
  BrokaMac, 19-20
  FlyPaper, 23-24
  MacBarf, 65-66
  Sneezomatic, 69-70
  Solvent, 26-27
  Sonic Boom, 82-83
System 7 installations
  Backwords, 36
  BrokaMac, 18-19
  DOS sHELL, 14
  FlyPaper, 22-23
  MacBarf, 65-66
  Minitors, 15
  Mitten Touch-Typist, 53
  Moof, 40
  Sneezomatic, 69-70
  Solvent, 26
  Sonic Boom, 82-83
  Umlaut Òmlététê, 44
  technical support, 131-132
  Teixeira, Marcio Luis, 27, 54, 71, 83, 105
temporary disabling, 129
Termites, 111-114, 139
text
  diacritical marks, adding, 44
displaying backwards, 35-36
  entering, Trigger, 124
  substituting, 39-40, 44
  vanishing, 45
  vowel input, prohibiting, 55
time, adjusting termite infestation, 113
tricks
  disguising, 130
  hiding, 131
  locating, 129
  malfunctioning, 131
  technical support, 131-132
temporarily disabling, 129
Trigger, 121-126, 138
Tweety, 77-79, 140
typing errors, 53
U-V
  Òmlaut Òmlététê, 40, 43-44, 140
  Vanags, Peter, 121, 126
  Vanish, 45, 140
  vanishing, text, 45
  View menu commands, By Icon, 40, 46
  virus prevention, 129-130
  vomiting sound effect, 65
  vowels, prohibiting input, 55
W-Z
  Weiss, Jay D., 14
  Welch, Andrew, 114
  windows
    Alert Sender (Trigger), 124
    munching, 103-104
  Yu, Dean, 120
About the Disk

The enclosed 800k, 3.5-inch disk contains 33 programs in a self-extracting archive. You will need 1.1M of hard disk space to store the uncompressed programs. For more information on installing the programs, turn to Appendix B.

All of the tricks on the disks are described in complete detail in the book. The chapters include information about installation, compatibility, and contacting the program’s author. See specific chapters for more information about the following programs, or turn to Appendix C for a brief look at each program.

**Startup Tricks**
The first seven tricks covered in this book all affect the startup process in one nasty way or another. StartupScreens, DOS sHELL, Minitors, BrokaMac, FlyPaper, Solvent, and Playin’ Possum create serious-looking and (sometimes) -sounding problems.

**Text Tricks**
The seven tricks covered in this section all modify the appearance of text or how it’s entered. Backwords, Moof, Ümlâüü Ömêléttê, Vanish, HAL Edit, Mitten Touch-Typist, and NVwls drive your victim crazy by replacing letters, preventing letters from being entered, reversing text, and more!

**Sound Tricks**
The eight tricks covered in this section all rely heavily on sound effects. Make your victim’s computer puke, sniff, scream, sneeze, chirp, and more with Conan The Librarian, Off Hook, MacBarf, Sneezomatic, Sniff, Tweety, Sonic Boom, and Squeaker.

**Menu Tricks**
Enchanted Menus and MenuHack keeps your victims dazed and confused as they try to make choices from menus that won’t stay put.

**Miscellaneous Tricks**
April Fools, Burning Fuse, Dimwit, Munch, Sexplosion, Sproing and Termites are a hodge-podge of devious and demented programs that don’t fit into any convenient pigeon hole. You’ll have to see them to believe them!

**Network Tricks**
Cause havoc from afar with these two tricks. NetDino lets you set a dinosaur on a screaming rampage across the screens of everybody connected to the network. Radiation lets you reach out across the network to make an alert box appear on your victim’s screen with whatever messages you want.
The Macintosh Joker
by Owen W. Linzmayer

© 1993 Hayden Books and its licensors. All rights reserved.

Double-click self-extracting icon to open a door to a world of revenge. (Use responsibly. Remember, your victim may have purchased this book, too.)

Hasty tricks include: Backwords, BrokeMac, Cohen The Librarian, Diecut, DOSIAHELL, Enchanted Mixer, FlyPaper, HAL Edits, Munch, OFF Hook, Scrapshaker, Summonsake, Subvert, Spying, Spinner, Unclutter Oodles, Vanish, and more!

To order more Hayden Books call (800) 428-3331.
ISBN 1-56030-079-4
Finally—your chance to stick it to the other guy. You know that office busy-body who's always bugging you with his bad puns? Or that know-it-all friend who's always sabotaging your day with her practical jokes? Now it's your turn to get even!

The Macintosh Joker deals out a perfect hand of pranks you can play on your friend's Macintosh. This book/disk set contains 33 devilish, delightful tricks that sabotage the Mac—but do no harm whatsoever. You can make a Mac barf, distort text, act like it's got a cold, simulate hard drive failure, and more. So the next time that busy-body gets on your nerves: don't get mad—get even!

Just a Few of the Nasty Pranks Included:

- **DOS sHELL**—makes the start-up screen look like an IBM, complete with a c:>
- **Backwords**—reverses all text, including words on icons, menus, and more
- **Solvent**—melts desktop until it disappears

Many of these tricks are available **ONLY** in this book, making it your exclusive source for fun revenge!

$19.95 U.S./$26.95 CAN

**INFORMATION CENTER:**
All User Levels
General Macintosh
All Macs Running System 6 or 7

**ISBN 1-56830-079-4**